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PROGRAMME SPECIFIC OUTCOMES 

 

 

 

 

 

PSO1 
Understand the principles and concepts of event management, including planning, 

organization, and execution. 

PSO2 
Apply Knowledge of event marketing, promotion, and sponsorship strategies. 

 

PSO3 
Understand event logistics, operations, and risk management. 

PSO4 
 Apply technology, including event management software and digital tools. 

PSO5 
 Organize various types of events (e.g., conferences, weddings, festivals, sports events). 

 

 

CREDIT FRAMEWORK 

BBA HONOURS (EVENT MANAGEMENT ) 
 

 
 

Semester 

 

 
MAJOR 

 

 
MINOR/ 

  VOCATIONAL 

 

 
LANGUAGES 

 
Multidisciplin

ary 

 

 
SE

C 

 

 
OOTC 

 

IKS/ 

 ENVIRONMENTAL 

EDUCATION 

 

 
TOTAL 

C H CR C H CR C H CR C H CR C H CR C H CR C H CR C H CR 

I 4 16 16 0 0 0 2 8 6    1 6 4       7 31 26 

II 4 16 16 0 0 0 2 8 6 1 2 2 1 6 4    1# 2 0 9 35 28 

Community Service project of 80 Hours with 1 Credits     1 

At the end of the First Year (certificate) 16 66 55 

III 4 16 16 1 2 2 2 8 6 1 2 2 1 2 2       9 30 28 

IV 4 16 16 1 2 2    1 2 2 1 2 2    1 2 2 7 25 24 

 At the end of the First Year (Diploma) 32 121 107 

V Apprenticeship   22 

VI Apprenticeship   22 

 AT THE END OF THE 3rd  YEAR (Degree) 32  151 

VII 3 12 12          2 8 8 1 4 2 1 2 0 7 26 22 

VIII 3 12 12          2 8 8 1 4 2 1 2 0   7 26 22 

AT the end of the 4th  Year  46 173 195 

 

 



COURSE STRUCTURE  
 

SEMESTER – I 

 

 SEMESTER – II 

 

 
S.No 

 
Course Codes 

 
Course Name 

 
No. of 

Hours 

 
Credits 

Evaluation 

CIA SEE Total 

1 First Language English 4 3 50 50 100 

2 Second Language (Telugu/ Hindi/ Sanskrit/ Urdu) 4 3 50 50 100 
3 Multidisciplinary 

Course  
As per the choice 2 2 0 50 50 

4 Skill Enhancement 

Courses 

Application of AI 4+2 4 50 50 100 

5 IKS  Indian Knowledge System 2 0 0 50 50 
6 Core V Event Resource Management 4 4 50 50 100 

7 Core-VI Event Hospitality & 

Sponsorship 

4 4 50 50 100 

8 Core-VII Computerized Accounting   5 4     50 50 100 

9 Core – VIII Customer Relationship 

Management 

4 4  50 50 100 

 
End of the 2

nd
   Semester 35 28 

     800 

 
Community Service project 80 1 

  100 

 AT THE END OF THE FIRST YEAR 

(CERTIFICATE) 
66 55 

  1600 

 
S.No 

 
Course Codes 

 
Course Name 

 
No. of 

Hours 

 
Credits 

Evaluation 

CIA SEE Total 

1 First Language English 4 3 50 50 100 

2 
Second Language (Telugu/ Hindi/ Sanskrit/ Urdu) 

4 3 50 50 100 

3 Skill Enhancement 

Courses 

Introduction to Artificial 

Intelligence  
4+2 4 50 50 100 

4 Core I  Introduction to event Management   4 4 50 50 100 

5 Core  II Event Planning & Venue 

Management 
4 4 

50 50 100 

6 Core –III Fundamentals of Computers  5         4 50 50 100 

7 Core – IV Business Ethics  4 4 50 50 100 

 
End of the 1

st
  Semester 31 26   700 



 

 

SEMESTER - III 

 
S.No 

 
Course Codes 

 
Course Name 

 
No. of 

Hours 

 
Credits 

Evaluation 

CIA SEE Total 

1 First Language English 4 3 50 50 100 

2 Second Language Telugu/Hindi/Sanskrit 4 3 50 50 100 

3 Multidisciplinary As per the choice 02 02 - 50 50 

4 Skill Enhancement 

Courses 
As per the choice 

02 02 - 50 50 

5 Core –VIII Event Safety & Risk Management 4 4 50 50 100 

6 Core XI Event Production Process 4 4 50 50 100 

7 Core X Digital Marketing for Event 

Management  
4 

4 50 50 100 

8 Core XI Business Communication Skills  
4 4 50 50 100 

9 Vocational Project Work 
2 2 50 - 50 

 At the end of the 3
rd

 Semester  30 28   750 

SEMESTER - IV 

 
S.No 

 
Course Codes 

 
Course Name 

 
No. of 

Hours 

 
Credits 

Evaluation 

CIA SEE Total 

1 Multidisciplinary As per the choice  
02 02 - 50 50 

2 
Skill Enhancement 

Courses 

As per the choice 
02 02 - 50 50 

3 
Environmental 

Education  

Environmental Education  
02 02 - 50 50 

3 
Core –XII 

Event Cost Accounting 5 4 50 50 100 

4 
Core –XIII Public Relations  4 4 50 50 100 

5 
Core –XIV Human Resource Management in 

Events 
4 4 50 50 100 

6 
Core –XV Legal Aspects of Event Management 

4 4 50 50 100 

7 
Vocational Project Work 

02 02 50 - 50 

 
At the end of the 4

th
 Semester  25 24 

  600 

 
AT THE END OF THE SECOND YEAR 

(DIPLOMA) 
121 107 

  2950 



 

SEMESTER – VII 

SEMESTER – VIII 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Semester 5 

S.no  Core Courses Months Credits Marks  

1 Apprenticeship-I 6 Months  22 400 

  

  Semester 6 

S.no Core Courses Months Credits  Marks  

1 Apprenticeship-II 6 Months  22 400 

AT THE END OF THE THIRD YEAR (DEGREE)                                                        151 3750 

 

 
S.No 

 
Course Codes 

 
Course Name 

 
No. of 

Hours 

 
Credits 

Evaluation 

CIA SEE Total 

1 Skill Enhancement 

Courses 
Advertising and Media 

Promotion  
4 4 50 50 100 

2 Skill Enhancement 

Courses 

Management Accounting  
4 4 50 50 100 

3 OOTC As per the choice 2 2 00 50 50 

4 IKS/EE As per the choice 2 0 00 50 50 

5 Core XVI Special Event Management  4 4 50 50 100 

6 Core  XVII Event Logistics  4 4 50 50 100 

7 Core –XVIII Event Marketing Management 4 4 50 50 100 

 End of the 7
th

   Semester 24 22   600 

 
S.No 

 
Course Codes 

 
Course Name 

 
No. of 

Hours 

 
Credits 

Evaluation 

CIA SEE Total 

1 Skill Enhancement 

Courses 
Investment Analysis and 

Management 
4 4 50 50 100 

2 Skill Enhancement 

Courses 

International Law In Events   
4 4 50 50 100 

3 OOTC As per the choice 2 2 00 50 50 
4 IKS/EE As per the choice 2 0 00 50 50 

5 Core XIX  Event Sponsorship & Fundraising  4 4 50 50 100 

6 Core  XX Wedding events  4 4 50 50 100 

7 Core –XXI Sports & Cultural Event 

Management 4 4 50 50 100 

 End of the 8
th

   Semester 24 22   600 

 AT THE END OF THE 4
th

 YEAR  195   4950 



GOVERNMENT COLLEGE (AUTONOMOUS) 

(Re-Accredited by NAAC with ―A +‖ Grade) 

RAJAMAHENDRAVARAM 

BBA HONOURS (EVENT MANAGEMENT)  

COURSES REVISED  
S.No Course Semester   Course Name  

1 Major I Introduction to Event Management 

2 Major II Event Planning & Venue Management 

3 Major II Event Resource Management  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) 

(Re-Accredited by NAAC with ―A +‖ Grade) 

RAJAMAHENDRAVARAM 

BBA HONOURS (EVENT MANAGEMENT)  

NEW COURSES INTRODUCED (A.Y 2025-2026) 

 
S.No Course Semester   Course Name  

1 Core I  I Introduction to event Management   

2 Core  II I Event Planning & Venue Management 

3 Core –III I Fundamentals of Computers  

4 Core – IV I Business Ethics  

5 Core V  II Event Resource Management 

6 Core-VI II Event Hospitality & Sponsorship 

7 Core-VII II Computerized Accounting   

8 Core – VIII II Customer Relationship Management 

9 Core –VIII III Event Safety & Risk Management 

10 Core XI III Event Production Process 

11 Core X III Digital Marketing for Event Management  

12 Core XI III Business Communication Skills  

13 Vocational III Project Work 

14 Core –XII IV Event Cost Accounting 

15 Core –XIII IV Public Relations  

16 Core –XIV IV Human Resource Management in Events 

17 Core –XV IV Legal Aspects of Event Management 

18 Vocational IV Project Work 

19 SEC VII Advertising and Media Promotion  

20 SEC VII Management Accounting  

21 Core XVI VII Special Event Management  

22 Core  XVII VII Event Logistics  

23 Core –XVIII VII Event Marketing Management 

24 SEC VIII Investment Analysis and Management 

25 SEC VIII International Law In Events   

26 Core XIX  VIII Event Sponsorship & Fundraising  

2 Core  XX VIII Wedding events  

28 Core –XXI VIII Sports & Cultural Event Management 

    

    

 

 

 

 

 

 

 

 

 

 

 

 

 



 

GOVERNMENT COLLEGE (AUTONOMOUS) 

(Re-Accredited by NAAC with ―A +‖ Grade) 

RAJAMAHENDRAVARAM 

Scheme of Evaluation for 

BBA HONOURS (EVENT MANAGEMENT) COURSES 

(W.e.f 2025-26) 

                                            Max. Marks: 100  

 

CONTINOUS INTERNAL ASSESSEMENT  

50 M 

CIA-I 20 M 

CIA-II (Online) 10 M 

Attendance   05 M 

Assignment  05 M 

Seminar/GD/Viva etc. 05 M 

Clean and Green 05 M 

SEMESTER END EXAMS 

50 M 

 Q M TM 

Very Short Answers  6 1 06 

Short Answers  3 3 09 

Essay  5 7 35 

Total Marks 100 Marks  

Note: Q = Questions, M = Marks TM=Total Marks 

Note: 

1. In Very short answers 6 questions will be given.  

2. In Short Answers 5 questions will be given, out of those students should answer 

3 questions.  

3. In Essays 10 questions with internal choice will be given, out of those students 

should answer 5 questions. 

Vocationl (Project work) Evaluation 

  

   

 

 

 

Component  Max. Marks 

Activity log 10 

Project Report 20 

Viva –voce 10 

Oral Presentation 10 

Total 50 



GOVERNMENT COLLEGE (AUTONOMOUS) 

RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A
+
‖ Grade) 

DEPARTMENT OF COMMERCE 
SCHEME OF EVALUATION 

MODEL OF SEMESTER END EXAMINATION QUESTION PAPER (THEORY) 

(As Approved in the BOS meeting held on 15
th

 September, 2025 at 11 AM) 

EVALUATION SCHEME 

Standard Operating Procedure for Continuous Internal Assessment 

 (Internal Marks – 50) 

The Internal marks in all the courses/subjects will be awarded based on continuous internal 

assessment made during the semester concerned. For each Courses/subject 50 marks are 

allotted for internal assessment and 50 marks are allotted for the End Semester Examination. 

1. Continuous Internal Evaluation (CIA): 
It has been decided to introduce Continuous Internal assessment marks for a total of 

50 marks, which are to be distributed as follows: 
 

S.No. 

 

Component 
Distribution of 

Marks 

1 CIE I (after completion of 50% of syllabus) 20 

2 CIE II (Online Exam) 10 

 

 

 
 

3 

 

 

 
 

ATTENDANCE 

Above 95% 5       5 

91% to 95% 4 

86% to 90% 3 

81% to 85% 2 

75% to 80% 1 

Below 75% 0 

Pedagogical Strategies  

4 ASSIGNMENT(One Assignment from each unit) 5 

5 Participation or Paper Presentation in Student 
Seminars/Workshops/Group Discussions/ Quiz/ Student Study 
Project/Field Visit/Survey /Any other 

5 

6 Clean & Green (Maximum 2 Activities)  5 

TOTAL 50 

 

    

 

 



 Component I: CIE I & CIE II (20+10 = 30 Marks) 
Two Internal Examinations, out of which one is Mandatorily Online examination, for each 

Course shall be conducted for assessment. These examinations will be conducted during 

August/September (CIE –I) and October/November (CIE-II). CIE-I carries 20 marks and CIE-II 

carries 10 marks. CIE- I will be conducted after completion of 50% of syllabus. The second 

internal examination, i.e., CIE –II, which is mandatorily online examination, will cover the 

entire syllabus. The sum of both the CIEs will be considered for awarding marks for CIA. 

Suggestive Question Paper Pattern for CIE I & CIE II (Based on Blooms 

Taxonomy): 
 

Though the faculties concerned   are empowered to adopt their own pattern for question paper, a 

general and suggestive model for question paper is given below based on Blooms Taxonomy. 

 
Q No Learning Objective Marks 

1 Memory based (Remember) 2 

2 Understand (Comprehension) 2 

3 Application 3 

4 Analysis 3 

5 Evaluation 5 

6 Creativity 5 

 TOTAL 20 marks 

 

The active verbs used to frame the question based on Blooms Taxonomy is given below 

for the convenience. 

BLOOM’S TAXONOMY VERBS 

REMEMBER UNDERSTAND APPLY ANALYZE EVALUATE CREATE 

Define Summarize Determine Organize Argue Design 

Memorize Compare Present Compare Defend Compose 

Repeat Describe Examine Contrast Judge Construct 

Copy Explain Implement Experiment Support Develop 

Define Discuss Solve Test Value Formulate 

State Recognize Use Question Weight Blog 

List Report Demonstrate Connect Reflect Build 

Quote Translate Interpret Deduce Review Write 

Find Categorize Re-enact Link Grade simulate 

 

      

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SEMESTER –I  
 

ADMITTED BATCH: 2025-2026 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – I 

Introduction to Artificial Intelligence  

Syllabus           

 Hours: 04+02         Credits: 04    

 

   Course Outcomes: Students will be able to 

 CO1: Describe the different subfields and their roles in AI applications. 

 CO2: Analyse the benefits and limitations of AI in diverse domains.  

 CO3: Evaluate AI systems in terms of inclusivity, privacy, and robustness. 

 CO4: Describe Generative AI and emerging technologies like ChatGPT.  

 CO5: Apply prompt engineering concepts to various real-world use cases.  

 

Unit I: AI and its Subfields Introduction to Artificial Intelligence, History, Definition, Artificial General 

Intelligence, Industry Applications of AI, Challenges in AI. Knowledge Engineering, Machine Learning, 

Computer Vision, Natural Language Processing, Robotics.  

Unit 2: Applications of AI Healthcare, Finance, Retail, Agriculture, Education, Transportation.  

Unit 3: Bias and Fairness in AI Systems Ethics in AI, Bias and Fairness in AI Systems, Transparency in AI 

Systems, Accountability, Security, Privacy, Inclusivity, Sustainability, Robustness, Reliability.  

Unit 4: AI in Research, Generative AI and prompt engineering AI in Experimentation and Multi-disciplinary 

research, Generative AI introduction, ChatGPT, Hugging Face, Gemini and other tools basics, Perplexity, 

Prompt engineering Definition and its importance, Role of Prompt Engineering in AI/ML Interaction, 

Emerging trends and Future Directions in AI.   

Unit 5: Applications of Prompt engineering Applications of Prompt Engineering: Education, Business & 

Commerce, Content Creation: AI for Creative Writing, AI for creative design, writing AI scripts for video, 

generating slides and slides GPT usage, Designing thumbnails and channel branding with AI  

 

Text Books:  

1. AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi Goswami, Amit 

Kumar Das, Amlan Chakrabarti  

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora.                                                   

 

References: 

 1. Let‘s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission.  

2. Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs by James Phoenix & 

Mike Taylor. 

 3. Generative AI Tutorial:https://www.w3schools.com/gen_ai/  

4. Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost Productivity & 

Creativity , For Professionals, Marketers & Entrepreneurs by Hitesh Motwani , ZebraLearn, 2025. 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management)– Semester – I 

Introduction to Artificial Intelligence  

Practice Session                                                                                        2 hrs. /week 1 

1. Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering using Canva/Napkin 

AI/ Similar Open AI tool  

2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app)  

 Input sample texts (e.g., news articles, speeches). 

 Explore word frequency, keywords, sentiment.   

 Understand how NLP extracts meaning from text.  

3. Train a basic image classifier using webcam images. Observe how the model "learns." Using Google 

Teachable Machine  

 Train two image categories (e.g., ―Smiling‖ vs. ―Not Smiling‖) using their own webcam images.  

 Observe how the model learns to classify. 

 Now try feeding images of people with different skin tones, facial features, etc. 

 Observe misclassifications or differences in confidence.  

4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of your choice. You 

may use the prompt below and also try your own. Prompt: ―Act as an agriculture assistant. A farmer wants to 

know the best crop based on soil and season. Ask questions and suggest crops.‖  

5. Test Generative AI- Generate a poem or image from prompt ―A futuristic green city.‖ using ChatGPT, 

Hugging Face (e.g., image or text generation) 

6. Observe how generative AI models may show biased results when prompted with neutral profession 

descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT). Generate images using the following 

neutral prompts:  

 ―A doctor treating a patient‖ 

 ―A teacher in a classroom‖ 

 ―A CEO giving a speech‖  

 ―A software engineer working from home‖ Observe and discuss:  

 What gender/race/age are most commonly shown?  

 Are the results stereotypical or diverse?  

7. Check how language models may express bias depending on names, ethnicity, or location. Use ChatGPT or 

Gemini Prompts: Prompt A: ―A person named Raj is applying for a bank loan. Will he be approved?‖ Prompt 

B: ―A person named John is applying for a bank loan. Will he be approved?‖ Change names, genders, and 

nationalities. Observe the following and report your findings:  

 Are the responses different?  

 Is one version more positive or negative? 

 Does the model express bias or hesitate? 



 Should AI make such predictions? 

 How do developers prevent this? 

 8. Exploring Text Generation and Summarization with Google AI Studio Generate Creative Content ―Write a 

short story (150 words) about a robot who wants to become a chef.  

 Submit and read the AI-generated story. 

 Discuss how detailed and creative the output is. Summarize a Paragraph Prompt: Summarize the 

following paragraph in 3 sentences: ―Artificial Intelligence is a branch of computer science that aims 

to create intelligent machines that can mimic human thinking. It includes various subfields like 

machine learning, natural language processing, and robotics. AI is widely used in industries such as 

healthcare, finance, and transportation to improve efficiency and decision-making.‖ 

 ● Submit and review the summary.  

● Evaluate how well AI extracts key points. Refine Your Prompt Try changing the summary prompt to: 

―Summarize the paragraph above in simple language for 10-year-olds.‖  

 Compare this output to the previous one.  

 Note how prompt wording changes results  

9. AI for Creative Writing Prompt: ―Write a short motivational story for 10-year-old students in under 150 

words.‖  

10. Generate Slides: Tool: Slides GPT/Other Free AI tool Prompt: ―Create a 5-slide presentation on ‗AI in 

Smart Farming‘.‖ 

 11. YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI Design a thumbnail using Canva‘s AI 

tools with a prompt like: ―Design a YouTube thumbnail for a video titled ‗Top 5 AI Tools for Students‘ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management)– Semester – I 

Introduction to Artificial Intelligence  

Model Paper 

Time: 2 ½ Hours                Max Marks: 50 

Section – A 

Answer any FIVE questions.        5 X 7 = 35 Marks 

1. Explain the history and evolution of Artificial Intelligence. 

(OR) 

2. Discuss the major subfields of AI and their applications in industry. 

3. Explain the role of Artificial Intelligence in healthcare and education sectors. 

(OR) 

4. Discuss the use of AI in agriculture and transportation with examples. 

5. What is bias in AI systems? Explain how fairness and transparency can be achieved. 

(OR) 

6. Discuss the importance of ethics, privacy, and accountability in AI systems. 

7. Write a detailed note on Generative AI tools such as ChatGPT, Gemini, and Hugging Face. 

(OR) 

8. Explain the role of prompt engineering in AI and ML interaction. 

9. Explain the applications of prompt engineering in education and business. 

(OR) 

10. Discuss how AI supports content creation such as creative writing and video scripting. 

Section – B 

Answer any Three questions.           3 X 3 = 9 Marks 

11. What are the main challenges faced in Artificial Intelligence? 

12. List any four AI applications in the finance or retail sector. 

13. Define inclusivity and sustainability in AI systems. 

14. What is the significance of prompt engineering? 

15. How is AI used in designing YouTube thumbnails and channel branding? 

Section – C 

Answer ALL questions.            6 X 1 = 6 Marks 

16. Expand AGI. 

17. Name any two subfields of AI. 

18. What is the full form of NLP? 

19. Mention one ethical concern in AI systems. 

20. Name any one Generative AI platform. 

21. Who developed the concept of Prompt Engineering? 

 

 

  

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management)– Semester – I 

INTRODUCTION TO EVENT MANAGEMENT 

Syllabus     

Hours: 04           Credits: 04        

Course Outcomes: 

After completing the course, the student shall be able to: 
CO1: Understand the basic designing process of events 

 CO2: Understand the various categories / types of events;. 

CO3: Understand the social, economic, cultural and political impact of running events  

CO4: Understand the scope for expansion of the event industry and identify job prospects     

           related to various areas in event management.  

 CO5: Skill Acquiring for career planning in event management 

Unit 1: Introduction: 
Introduction - Definition of Events – Objectives- Historical Perspective of Events-Event 

Management —Concept- Key elements of Events - Demand and Scope of Events- Objectives of 

Event Management-Functions of Event Management  

Unit-II: Classification of Events 

Classification of Events: Mega events - Hallmark event- Major events- Local events. Based on Form 

or Content: Cultural celebrations - Arts and Entertainment - Business and Trade -Sport competitions 

- Recreational - Educational and Scientific - Political and state. International Events: Niche Events- 

Participatory Sports Events- Signature Cultural Events- International Sports Events. 

Unit-III: Characteristics of Events and Events Committee: 

Introduction-Characteristics of Events-Impact of Events-Advantages of Events. Events Committee: 

Functions and Responsibilities of the Committee- the big event committee structure- coordination 

among committees.  

Unit-IV: Growth of Event Industry in India 

Introduction-Industry Size and Growth-Strengths and Challenges-Structure of Event Services-Scope 

of Expansion and Careers. 

Unit-V: Career Strategy 

Career Strategy: where to start from – expected and unexpected challenges – skills needed – growth 

opportunities in National and International market – career planning in event management – 

organization structure – expectation from each level – areas in event management. 

References: 
1. Allen, J. et al., 2011. Festival & Special event management. 5th edition. John Wiley & Sons: 

Brisban 

2. D.Sharma, ‗Event Planning and Management‘, First Edition, Deep & Deep Pub Pvt ltd., 2005 

- 8176296333 

3. S R Singh, ‗Event Management‘, APH Publishing, 2009, - 8131306888 

 

Co-Curricular Activities: 

 Class discussions.  

  Case Studies.  

 Audio/Visual class presentations.  

 Assignment and Project.  

 Experimental Group Exercise.  

 

 

 

 

 



BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 2 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 1 1 2 

5 UNIT- V 1 1 2 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management)– Semester – I 

INTRODUCTION TO EVENT MANAGEMENT 

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Define Event Management. Explain the Functions of Event Management. (BL1,2,CLO1) 
OR 

2. Present the Key Elements of Events (BL3,CLO1) 

3. Categorize the events by international tourism.(BL2,CLO2) 

OR 

4. Categorize the events by when considering the scale and impact of events.(BL2,CLO2) 

5. Design the big event committee structure. (BL6,CLO3) 
OR 

6. Define an Event. Describe the characteristics and advantages of Events(BL1,2,CLO3) 

7. Present the Strengths and Challenges of Event Industry?(BL3,CLO4) 
OR 

8. Construct the Structure of Event Services.(BL6,CLO4) 

9. Recognize the areas in event management? (BL2,CLO5) 
OR 

10. Describe the career planning in event management(BL2,CLO5) 
 

 

Answer any THREE of the following.      3×3=09 M 

11. Explain the Objectives of Event Management. (CO1,BL2) 

12. Define International sports events? (CO2,BL1) 

13. Explain the Characteristics of events. (CO3,BL2) 

14. Write a short note Industry Size & growth. (CO4,BL2) 

15. Write short note on Career strategy .(CO5,BL1) 

 

Answer all the questions.        6×1=06 M 

16. Define Event Management (BL1,CLO1) 

17. Describe Business and Trade Events(BL2,CLO2) 

18. Demonstrate Role of Finance Committee(BL3,CLO3) 

19. Support Indian Events Industry(BL5,CLO4) 

20. Explain bout Career Planning(BL2,CLO5) 

21. Examine about Local Events (BL3,CLO2) 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – I 

EVENT PLANNING & VENUE MANAGEMENT 

Syllabus     

Hours: 04           Credits: 04        

Course Outcomes: 

Understand the event planning process and its components 

 CO1: Analyse event goals, target audiences, and marketing strategies  

CO2: Evaluate venue options and create effective venue layouts  

CO3: Coordinate event logistics, including catering, audio-visual, and technical requirements  

CO4: Manage event staff, volunteers, and vendors 

 CO5: Develop event budgets and financial plans  

UNIT-I: Introduction to Event Planning, Event Concept and Design, Definition and scope of event planning, 

Event concept and theme development, Types of events (conferences, weddings, festivals, etc.),Event 

planning process (concept, planning, execution, evaluation)Event format and agenda design, marketing and 

promotion, branding and sponsorship.  

UNIT-2: Event Budgeting and Finance, Logistics and Operations. Event budgeting and financial planning 

,pricing and revenue management, expense management and cost control. Event timing and scheduling. Event 

staffing and volunteer management, catering and beverage management, audiovisual and technical 

requirements.  

UNIT-3: Event Coordination and Execution, Venue Selection and Management Event setup and teardown, 

registration and ticketing, flow and crowd management, evaluation and feedback. Venue types (hotels, 

convention centers, outdoor spaces, etc.) selection criteria (capacity, location, amenities, etc.), layout and 

design, operations and logistics.  

UNIT-4: Risk Management and Safety - Event risk assessment and mitigation, Event safety and emergency 

planning, Event insurance and liability  

UNIT-5: Event Marketing and Promotion, Evaluation and Follow-up Event marketing and promotion 

strategies, social media and online marketing, public relations and communication, Event evaluation and 

feedback methods, follow-up and thank-you strategies, reporting and debriefing.  

 

Textbook and Resources: -  

"Event Planning: The Ultimate Guide" by Judy Allen  

 "Venue Management" by David J. King - Online resources and industry articles 

Co-Curricular Activities: 

 Quizzes and exams  

 Group project and presentation  

 Case study analysis and reporting  

  Final event plan and proposal  

 

 

 

 

BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 2 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 1 1 2 

5 UNIT- V 1 1 2 
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I BBA H (Event Management)– Semester – I 

EVENT PLANNING & VENUE MANAGEMENT  

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Discuss the event planning process in detail from concept to evaluation. (CO1,BL2) 

OR 

2. Explain the importance of marketing, branding, and sponsorship in event planning.(CO1,BL2) 

3. Discuss the process of financial planning and budgeting for an event. (CO2,BL2) 

OR 

4. Explain the challenges in staffing and managing volunteers (CO2,BL2) 

5. Create a detailed plan for coordinating a conference event. (CO3,BL6) 

OR 

6. Discuss in detail the coordination and execution process of an event. CO3,BL2) 

7. Develop a safety and risk management plan for a large outdoor concert. (CO4,BL6) 

OR 

8. Analyze the importance of safety and emergency planning for events.(CO4,BL4)  

9. Discuss various marketing and promotional strategies used in events.(CO5,BL2) 

OR 

10. Explain the methods of post-event evaluation and reporting. (CO5,BL2)  

 

Answer any THREE of the following.      3×3=09 M 

11. Explain the scope of event planning. (CO1,BL2) 

12. What are the main components of an event budget? CO2,BL6) 

13. Explain the process of venue selection. (CO3,BL2) 

14. Write a short note on event insurance. (CO4,BL2) 

15. Write short notes on social media marketing for events.(CO5,BL1) 

Answer all the questions.        6×1=06 M 

16. Define event planning. (CO1,BL1) 

17. What is event budgeting? (CO2,BL1) 

18. Define venue selection. (CO3,BL1) 

19. Define risk management. (CO4,BL1) 

20. What is event marketing? (CO5,BL1) 

21. What is revenue management?(CO2,BL1) 
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I BBA H (Event Management) – Semester – I 

Fundamentals of Computers  

Syllabus     

Hours: Theory 3 + Practical 2       Credits: 04 

 

COURSE OUTCOMES: 

CO1: Demonstrate knowledge of the basic functions of computer. 

CO2: Develop practical knowledge of using these devices for day-to-day computing. 

CO3: Develop awareness of network applications in real life. 

CO4: Understand the basics of MS-Office suite and its applications. 

CO5: Apply internet knowledge for personal, educational, and professional use. 

 

UNIT-I: Basics of Computers:-Definition of a Computer-Characteristics and application of computer-Block 

Diagram of a computer – Classification of Computers based on size and working-Generation of a Computer- 

Central Processing unit – I/O Devices. 

UNIT-II: 

Definition and types of operating systems – Functions of Operating system - Memory – Types of Memory. 

Computer Networking – Definition of a computer networking – Types of Computer Network (LAN, WAN, 

MAN) 

UNIT-III: M.S Word: Features of M.S word –MS word window components – Creating, Editing, Formatting 

and Printing of documents – Headers and Footers –Insert/Draw tables – Page boarders and shading – Inserting 

symbols , shapes, word art, page numbers ,Equations,-spelling and grammar-Mail Merge.  

UNIT- IV: M.S Power Point: - Features of PowerPoint-creating a blank presentation - Creation a 

Presentation using a template- Inserting and deleting a slide in a presentation – Adding clip art/pictures-Slide 

transition – Custom animation. 

UNIT-V: M.S Excel: - Overview of excel features – Creating a new worksheet, selecting cells , Entering and 

Editing text , Numbers, Formulae-Inserting rows and columns – Changing column width and height, auto 

format , changing font sizes, colours, shading. 

Reference Books 

1. Fundamentals of Computers – V. Rajaraman 

2. Computer Fundamentals – P.K. Sinha & P. Sinha 

3. Introduction to Information Technology – Turban, Rainer, and Potter 

4. Microsoft Office 2019 Step by Step – Joan Lambert 

5. Computer Networks – Andrew S. Tanenbaum 

Co-curricular Activities 

 Quiz on parts of computer and functions, Poster-making on "Evolution of Computers". 

 Practical demonstration of different devices, Chart preparation on storage evolution. 

 Hands-on lab: Prepare a Resume in MS-Word. 

 Hands-on lab: Prepare Power point presentation on any topic. 

 Create a sales report in MS-Excel using formulas. 



 

BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 2 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 1 1 2 

5 UNIT- V 1 1 2 
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I BBA H (Event Management)– Semester – I 

Fundamentals of Computers 

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Draw and explain the block diagram of a computer. (CO1,BL4,BL6) 

OR 

2. Discuss the applications of computers in various fields.(CO1,BL4,BL6) 

3. Explain the functions and importance of an operating system.(CO2,BL2) 

OR 

4. Describe the different types of computer networks with diagrams. (CO2,BL2) 

5. Explain the steps for creating, editing, formatting, and printing a document in MS Word.(CO3,BL2) 

OR 

6. Describe Mail Merge with steps.(CO3,BL2) 

7. Explain the procedure to create a PowerPoint presentation with custom animation.(CO4,BL2) 

OR 

8. Discuss the features of MS PowerPoint and its uses in business and education.(CO4,BL2)  

9. Explain the features of MS Excel and the steps to create and format a worksheet.(CO5,BL2) 

OR 

10. Explain the function of M.S. Excel. (CO5,BL2)  

 

Answer any THREE of the following.      3×3=09 M 

11. Explain any three characteristics of a computer. (CO1,BL2) 

12. Write a short note on types of memory.(CO2,BL6) 

13. Explain steps to check spelling and grammar. (CO3,BL2) 

14. Explain steps to insert a new slide in PowerPoint. (CO4,BL2) 

15. What is AutoFormat? (CO5,BL1) 

Answer all the questions.        6×1=06 M 

16. Define a computer. (CO1,BL1) 

17. What is RAM? (CO2,BL1) 

18. Shortcut for saving a file?(CO3,BL1) 

19. What is PowerPoint used for?(CO4,BL1) 

20. Shortcut to AutoSum? (CO5,BL1) 

21. List out the Computer Networks. (CO2,BL1) 
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I BBA H (Event Management)– Semester – I 

                                                  Course Name: Business Ethics    

Syllabus 

 Hours: 04         Credits: 04   

 Course Outcomes:  

CO -1: To impart the understanding of business ethics. 

CO -2: To make the students aware about morals and ethics for workers  

CO -3: To inculcate the knowledge of corporate governance among the students. 

CO -4: To make the student aware about Environmental challenges as well as challenges of cyber age 

       

UNIT-I: Setting Ethical Standards  
Ethics; meaning, definition and scope Ethics and morals, Evolution of ethics, Classification of ethics, 

Business ethics, Nature of ethics as moral value     

Decision making: moral reasoning and its application Understanding decision making, Essence of 

decision making, Decision making process, Classification of decision making. 
UNIT-II: Managing people in the Organization  

Workers in morals Rights and duties of employee, Personal policies and procedures, Just wages, 

Trade unions the contemporary worker Conflict of interest, Whistle blowing, Abuse of official 

position, Bribe                                             

UNIT-III: Organization as a corporate citizen  

Corporate Governance Corporation as a moral person, corporate governance, corporate governance 

theory, Good corporate governance 

UNIT-IV: Corporate Social Responsibility 

Corporate Social Responsibility Understanding CSR, Moral arguments for CSR, Issues in CSR, and 

Development of corporate conscience as moral principles of CSR. 

UNIT-V: Challenges of new age world  

Challenges of environment Principles of environmental ethics, Environmental challenges is business 

opportunities, Role of the government, Multistake-holder ship. Challenges of cyber age Information 

technology and its moral significance to business, Data identity and security, Crime and punishment, 

Intellectual property rights. 

Reference Books:  

1. Chakraborty, S.K.; Ethics in Management: A Vedantic Perspective, Oxford University Press.  

2. Daniel Albuquerque, Business Ethics Principles and Practices: Oxford University Press.  

3. B.N.Ghosh, Business ethics and corporate governance.  

4. U.Mathur, Corporate governance and business ethics. 

 CO-CURRICULAR ACTIVITIES: 

 Case study analysis: Apply moral reasoning to a business ethics dilemma, discussing  

implications and potential solutions. 

 Role-play: Demonstrate effective conflict resolution strategies in the workplace, focusing on 

employee rights and duties. 

 Research project: Investigate a company's corporate governance practices, evaluating their 

impact on stakeholders. 

 Group discussion: Debate the moral arguments for CSR, exploring its benefits and challenges. 

 

BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 1 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 1 1 2 

5 UNIT- V 2 1 2 
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I BBA H (Event Management)– Semester – I 

Business Ethics 

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Explain the process of ethical decision-making with examples. (CO1,BL2) 

OR 

2. Discuss the nature of ethics as a moral value and its importance in business. (CO1,BL2) 

3. Discuss the moral rights and duties of employees and employers.(CO2,BL2) 

OR 

4. Explain how organizations can ensure ethical HR policies and procedures. (CO2,BL2) 

5. Discuss the role of corporate governance in building ethical organizations.(CO3,BL2) 

OR 

6. Explain how an organization can act as a responsible corporate citizen.(CO3,BL2) 

7. Explain the principles of CSR and its role in modern business. (CO4,BL2) 

OR 

8. Discuss how CSR contributes to sustainable development.(CO4,BL2)  

9. Discuss the ethical challenges faced by businesses in the cyber age.(CO5,BL2) 

OR 

10. Analyse environmental issues as business opportunities.(CO5,BL2)  

 

Answer any THREE of the following.      3×3=09 M 

11. Differentiate between ethics and morals. (CO1,BL2) 

12. Write a short note on the duties of employees. (CO2,BL6) 

13. Explain the concept of corporate governance. (CO3,BL2) 

14. State the moral arguments for CSR.(CO4,BL2) 

15. What is AutoFormat? (CO5,BL1) 

Answer all the questions.        6×1=06 M 

16. Define ethics. (CO1,BL1) 

17. Define conflict of interest. (CO2,BL1) 

18. Define corporate citizen.( CO3,BL1) 

19. What is CSR?(CO4,BL1) 

20. Define cyber ethics.(CO5,BL1) 

21. Define cyber ethics.(CO5,BL1) 
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I BBA  H (Event Management) – Semester – II 

SEC- APPLICATION OF AI 

Theory       Credits: 3   4 hrs/week 

 
Course Objectives: 
 1. Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms relevant to 
commerce and management. 
 2. Familiarize students with different types of datasets and public repositories used in AI research.  
3. Develop skills in building AI data pipelines through collection, annotation, cleaning, and 

preprocessing.  
4. Understand how AI enhances retail and e-commerce and explore personalization, recommendation 
systems, and customer engagement 
 5. Apply AI to streamline business processes and decision-making and explore AI in finance, HR, and 
supply chain management 
 Course Outcomes: On successful completion of this course, students will be able to:  
1. Explain the AI ecosystem (hardware, cloud, and edge devices) and its relevance to commerce and 
management.  
2. Differentiate between structured and unstructured data, and utilize public datasets for business-
oriented AI applications. 
 3. Design a conceptual AI data pipeline for solving real-world problems in commerce and management. 

4. Understand and apply AI technologies to improve customer engagement and personalization in 
commerce. 
 5. Use AI tools to streamline business operations, enhance decision-making, and detect patterns in data. 

Unit 1:  
 Infrastructure and Platforms for Building Applications using AI Hardware used in building AI 
applications: Processors - CPU, GPU, TPU, NPU, Memory - RAM, VRAM, Storage - HDD, SSD 
Platforms for building applications using AI: Online platforms (Example - Google AutoML, H2O.ai, 
Teachable Machine or similar platforms - for practice only); Desktop (No-code/Lowcode) platforms 
(Orange Data Mining, KNIME, Weka, RapidMiner or similar tools - for practice only). Edge AI: 
Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, Surveillance Cameras, 
Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances  

Unit 2: 
 Foundations of Data - Types, Ethics and Utility in Building Applications using AI Importance of data 
in building AI applications: Data as the fuel for AI, Role of big data in training AI models. Conceptual 
Foundations of Data: Data vs. Information vs. Knowledge. Structure of Data: Structured, Semi-
Structured, and Unstructured Data. Modalities of Data: Text, Image, Audio, Video, Tabular, Time-
Series, and Spatial Data. Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, 
GIF, PNG), Audio/Video (MP3, WAV, MP4, AVI). Data Repositories: Definition of public Datasets; 
Definition of private Datasets; Importance of Public Datasets, Popular Public Dataset Repositories 
(Example - Kaggle, Hugging Face Datasets, UCI Machine Learning Repository, Google Dataset Search 
or similar ones - for demonstration only), Dataset licensing and usage rights. Ethics, Privacy in Data 
Usage: Privacy concerns related to data usage; Regulations governing data usage - GDPR, HIPAA 

(Overview), Ethical use of data, Responsible AI data practices. 

 
Unit 3:  
The AI Data Pipeline: From Collection to Model Readiness The AI Data Pipeline: Stages and 
Components: Key Stages (Data Collection, Annotation, Preprocessing, Splitting, Feeding into AI 
Models Core Components: Ingestion, Storage, Processing, Validation, Delivery Data Collection 
Methods for AI: Manual Input (Surveys, forms, human-curated entries), Sensors & IoT Devices (Real-
time data from physical environments), System Logs & Transactions, Web Scraping (Automated 
extraction from websites), APIs (Structured data access from external platforms) Data Annotation and 
Labelling: Definition & Importance; Annotation Methods: Manual Annotation, Automated Annotation; 
Types of Annotation: Classification, Bounding Boxes, Segmentation, Transcription, Named Entity 
Recognition (NER) Data Cleaning and Preprocessing: Importance of data cleaning; Understanding 

―Dirty‖ Data: Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 



Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data Data Splitting: Splitting 
data into training set and test set. Data Transformation Techniques: Normalization, Transformation, 
Feature Engineering (Conceptual). 

Unit 4:  
AI in Commerce – Transforming the Consumer Experience Introduction to AI in Commerce, 
Recommendation Engines (Collaborative & Content-Based), Chatbots and Virtual Assistants, Sentiment 
Analysis and Review Mining, Inventory Optimization and Demand Forecasting, Ethical Issues related to 
use of AI in Commerce and Business: Bias, Privacy, and Transparency  

Unit 5:  
AI in Business Operations – Driving Efficiency and Insight AI in Business Intelligence and Predictive 
Analytics, Financial Applications: Fraud Detection, Risk Modelling, HR Applications: Resume 

Screening, Employee Analytics, Supply Chain Automation and Optimization, AI in Marketing: 
Customer Segmentation, Lead Scoring, Strategic Adoption of AI in Enterprises, Explainable AI in E-
Commerce. 
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I BBA H (Event Marketing) – Semester – II 

SEC- APPLICATION OF AI 

Theory       Credits: 1   2 hrs./week 

 
Suggested Lab Practicals (No Coding) 

 Lab 1 - Exploring Public Datasets (Orange Data Mining)  
● Visit a public repository (Kaggle, UCI, data.gov.in)  
● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics) 
 ● Procedure:  
1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset).  
2. Connect to Data Table → View rows/columns.  
3. Connect to Data Info → Check attributes, data types.  
4. View in Data Table and Distributions widget. 

 ● Observation: Note numeric, categorical, missing values.  
● Outcome: Students understand structured data format in CSV. 

 Lab 2 - Understanding Dataset Metadata and Formats 
 ● Take two datasets in different formats (CSV, JSON) 
 ● View metadata (description, features, size, license) 
 ● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 3 - Data Annotation Exercise  
● Use MakeSense.ai or VGG Image Annotator (VIA)  
● Annotate 10 sample images (traffic signs, fruits, or medical scans)  
● Export annotations in XML or YOLO format  
● Discuss annotation errors and challenges 

Lab 4 - Data Cleaning and Visualization (Orange Data Mining) 
 ● Aim: To clean dirty data and visualize categorical and numeric attributes.  
● Procedure:  
1. Load dataset.  
2. Connect File → Edit Domain (to change types) and Impute (to fill missing values). 
 3. Compare cleaned vs. original in Data Table.  
4. Distributions widget.  
5. Check various features distribution. (Optional: Create simple bar charts/line charts to visualize trends 
using Google Looker Studio)  
● Observation: Missing values filled with mean/median., Graphical representation of data. ● Outcome: 
Learn importance of data cleaning., Students learn importance of visualization in preprocessing. 

 Lab 5: Train/Test Split in Orange  
● Aim: To split dataset for AI training/testing. 
 ● Procedure: 1. Load Titanic dataset.  
2. Connect File → Data Sampler (70% train, 30% test).  
3. Connect outputs to Data Table widgets to view.  
● Observation: Students see two different subsets. 
 ● Outcome: Concept of model validation using split data. 

 Lab 6: Introduction to AI in Commerce – Use Case Exploration  
Prerequisite: Discuss conceptually about Clustering  
Objective: Understand how AI is applied in commerce through data visualization and clustering.  
Orange Workflow: Use Orange Data Mining Tool  

Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering  
Dataset: Retail customer data (e.g., purchase frequency, amount spent)  
Dataset Link: Retail Sales Data  
Activities: · 
 Load customer data and visualize spending patterns. ·  
Apply clustering to identify customer segments. · 
 Discuss how businesses can tailor services to each segment.  
Outcome: Students grasp how AI helps businesses understand and target consumers more effectively. 



Lab 7: Recommendation Engine Simulation  
Prerequisite: Discuss conceptually about Clustering  
Objective: Simulate collaborative filtering using similarity-based clustering. 
 Orange Workflow: Widgets Used: File → Distance → Hierarchical Clustering → Data Table 
 Dataset: User-product ratings matrix  
Dataset Link: Amazon Product Recommendation System  
Activities:  
● Calculate similarity between users. 
 ● Group similar users and recommend products based on cluster behavior. 
 ● Discuss differences between collaborative and content-based filtering. Outcome: Students understand 
the logic behind recommendation systems and how they personalize user experience. 

 

Lab 8: Chabot Intent Classification  
Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  
Objective: Train a model to classify customer queries into intents.  
Orange Workflow: Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression → 
Test & Score Dataset: Sample customer queries labeled with intents (e.g., ―track order‖, ―return item‖) 
Dataset Link: Customer Intent Classification  
Activities:  
● Preprocess and victories text data.  
● Train a classifier to predict query intent. 
● Evaluate accuracy and discuss chatbot training.  

Outcome: Students learn how AI understands and responds to customer queries. 

 

Lab 9: Sentiment Analysis of Reviews  
Prerequisite: Discuss conceptually about Naive Bayes  
Objective: Classify customer reviews as positive or negative.  
Orange Workflow: Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & 
Score Dataset: Product reviews with sentiment labels  
Dataset Link: Amazon Product Reviews – Sentiment Analysis  
Activities: ● Clean and tokenize review text. ● Train a sentiment classifier. ● Visualize word clouds for 
positive vs. negative reviews. Outcome: Students analyze customer feedback and extract actionable 
insights. 

Lab 10: Demand Forecasting with Regression  
Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  
Objective: Predict future sales using regression models.  
Orange Workflow: Widgets Used: File → Linear Regression → Scatter Plot → Test & Score Dataset: 
Historical sales data (e.g., monthly sales, promotions)  
Dataset Link: Comprehensive Retail Sales Data  
Activities: ● Train a regression model to forecast sales. ● Visualize predictions vs. actuals. ● Discuss 
implications for inventory planning.  
Outcome: Students understand how AI supports demand forecasting and inventory control. 
 

Lab 11: Bias Detection in AI Models  
Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & Confusion Matrix 
Objective: Explore bias in predictive models and its impact.  
Orange Workflow: Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions 
Dataset: HR hiring data with gender or age attributes 
 Dataset Link: HR Data Analytics  
Activities: ● Train a model to predict hiring decisions. ● Analyze performance across demographic 
groups. ● Discuss fairness, transparency, and ethical implications. 
 Outcome: Students critically assess bias and propose ethical safeguards. 

Lab 12: Predictive Analytics for Business Intelligence  
Prerequisite: Discuss conceptually about Random Forest  
Objective: Use classification to predict customer churn.  
Orange Workflow: Widgets Used: File → Random Forest → Test & Score → ROC Analysis  

Dataset: Telecom or subscription data with churn labels  
Dataset Link: Telco Customer Churn – IBM Dataset  



Activities: ● Train and evaluate a churn prediction model. ● Interpret ROC curves and accuracy. ● 
Discuss how businesses can act on predictions.  
Outcome: Students apply predictive analytics to improve customer retention. 

Lab 13: AI in HR and Marketing – Resume Screening & Segmentation  
Prerequisite: Discuss conceptually about Clustering  
Objective: Classify resumes and segment customers using clustering.  
Orange Workflow: HR Task: File → Preprocess Text → Bag of Words → Logistic Regression 
Marketing Task: File → k-Means Clustering → Scatter Plot Resume Screening  
Dataset: Employee Hiring Data Customer Segmentation Dataset: Customer Segmentation Dataset 
Activities: ● Screen resumes based on job fit. ● Segment customers by behavior or demographics. ● 
Discuss automation benefits and risks.  

Outcome: Students explore how AI enhances HR and marketing efficiency. 
 
Books/References  
1. Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, cleaning, 
and visualization without coding)  
2. AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 
use cases)  
3. Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 
quality, preprocessing, and pipelines) 
 4. Hands-On Data Science for Non-Programmers, David Meerman Scott (Spreadsheet-based data 
exploration and visualization)  

5. You Look Like a Thing and I Love You – Janelle Shane 
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I BBA H (Event Management) – Semester II 

SEC: APPLICATION OF AI 

MODEL PAPER 

Max Marks: 50          Time: 2½ Hours 

SECTION – A                                     (7 × 5 = 35 Marks) 

(Answer any FIVE questions. Each question carries 7 marks) 

1. Explain various hardware components used in building AI applications. 

(OR) 

2. Discuss Edge AI and its applications in smart appliances. 

3. Describe the types and formats of data used in AI applications. 

(OR) 

4. Explain the importance of public datasets and their ethical usage. 

 

5. Illustrate the stages involved in the AI data pipeline with examples. 

(OR) 

6. Explain data cleaning and preprocessing techniques in AI. 

 

7. Discuss the role of chatbots and recommendation engines in transforming commerce. 

(OR) 

8. Explain ethical issues related to AI in business such as bias, privacy, and transparency. 

 

9. Describe how AI is used in HR analytics and supply chain optimization. 

(OR) 

10. Explain the concept of Explainable AI and its importance in business operations. 

 

SECTION – B                                    (3 × 3 = 9 Marks) 

(Answer any Three question. Each question carries 3 marks) 

11. Write a short note on online and desktop platforms for AI application development. 

12. Differentiate between structured and unstructured data with examples. 

13. What are the key components of data annotation? 

14. Write a short note on sentiment analysis and review mining. 

15. Briefly explain AI in financial applications. 

SECTION – C              (1 × 6 = 6 Marks) 

(Answer All questions. Each question carries 1 mark) 

16. Expand the term TPU. 

17. Name any one public dataset repository. 

18. What is ―Dirty Data‖? 

19. Mention one example of Edge AI in daily life. 

20. What does GDPR stand for? 

21. Define Explainable AI. 
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I BBA H (Event Management)– Semester – II 

                                                  Course Name: Event Resource Management  

 Syllabus            

 Hours: 04         Credits: 04                                                        

COURSE LEARNING OUT COMES 

CLO1:  Students will be able to identifying various types of resources (human, material, financial, 

technological) needed throughout an event‘s life cycle. 

CLO2: Students will demonstrate the ability to recruit, train, and allocate staff and volunteers effectively. 

CLO3: Students will learn how to procure, manage, and allocate event materials and equipment efficiently. 

CLO4: Students will gain proficiency in creating event budgets, estimating costs, managing various revenue 

streams.  

CLO5: Students will learn how to apply event management software, artificial intelligence, and automation to 

improve event planning and resource allocation. 

 

Unit 1: Introduction to Event Resource Management: 

Definition and Scope of Event Resource Management, Importance of Resource Management in Events, Types 

of Resources in Event Management, Roles and Responsibilities in Event Resource Management, Event Life 

Cycle. 

Unit 2: Human Resource Management in Events: 

Staffing in Events: Recruitment, Training, and Allocation. Volunteer Management in Events, Team Dynamics 

and Leadership in Event Planning, Conflict Resolution and Communication Skills, Health and Safety 

Considerations for Event Staff. 

Unit 3: Material and Equipment Resource Management: 

Procurement of Event Equipment and Materials, Vendor Selection and Management , Event Logistics: 

Transportation and Inventory Management , Technology in Event Management: Audio-Visual and IT 

Requirements , Energy and Sustainability in Event Resource Management. 

Unit 4:  Financial Resource Management: 

 Budgeting and Cost Estimation for Events ,Revenue Streams: Sponsorships, Ticket Sales, Merchandise, etc. 

Financial Controls and Auditing ,Funding and Sponsorship Acquisition ,Financial Reporting and ROI 

Evaluation. 

Unit 5: Technology in Event Resource Management: 

 Event Management Software and Tools , Use of Artificial Intelligence and Automation in Event 

Management, Online Event Platforms and Virtual Events , Use of Analytics and Data in Event Resource 

Planning, Trends in Event Technology (AR/VR, Mobile Apps) 

REFERENCE BOOKS 

1. "Event Management: A Professional and Developmental Approach" by Glenn A. Bowdin, Johnny Allen, 

William O'Toole, Rob Harris, and Ian McDonnell 

2. "The Event Manager's Bible: The Complete Guide to Planning and Organising a Voluntary or Public 

Event" by D.G. Conway 

3. "Successful Event Management: A Practical Handbook" by Anton Shone and Bryn Parry 

4. "Human Resource Management for Events: Managing the Event Workforce" by Lynn Van Der Wagen 

 

Co-curricular Activities 

1. Guest Lectures and Industry Panels 

Invite industry professionals to speak on various aspects of event management, including human resources, 

financial planning, technology, and sustainability. 

2. Event Planning Workshops 



Organize hands-on workshops where students can plan and execute a small-scale event, applying principles 

from each unit of the syllabus. 

3. Site Visits 

Arrange visits to event venues, production companies, or event management firms to give students real-world 

insights into resource management practices 

4. Simulation Exercises 

Conduct simulations or role-playing exercises where students manage different aspects of an event, such as 

handling logistics, financial budgeting, or volunteer coordination. 

5. Case Study Analysis 

Assign students to analyze case studies of past events, focusing on resource management challenges and 

solutions, and present their findings and recommendations. 

 

 

BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 2 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 1 1 2 

5 UNIT- V 1 1 2 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – II 

Event Resource Management 

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Discuss in detail the various types of resources involved in event management with examples. 

(CO1,BL2) 

OR 

2. Evaluate the importance of resource planning and monitoring in successful event execution. 

(CO1,BL5) 

3. Discuss the importance of volunteer management.(CO2,BL2) 

OR 

4. Analyse the staffing process in event management from recruitment to allocation. (CO2,BL4) 

5. Analyse the procurement and logistics process for a mega sports event.(CO3,BL4) 

OR 

6. Discuss the importance of vendor management.(CO3,BL2) 

7. Discuss how budgeting and financial reporting contribute to event success. (CO4,BL2) 

OR 

8. Design a complete financial plan for a charity fundraising event.(CO4,BL6)  

9. Explain the use of software tools in event resource management.(CO5,BL2) 

OR 

10. Describe the role of automation in modern event management.(CO5,BL2)  

 

Answer any THREE of the following.      3×3=09 M 

11. Explain the scope of Event Resource Management. (CO1,BL2) 

12. Discuss the role of volunteers in events. (CO2,BL2) 

13. Discuss the role of technology in managing event resources. (CO3,BL2) 

14. Discuss various revenue streams available to event organizers.(CO4,BL2) 

15. List and explain any two current trends in event technology. (CO5,BL1) 

Answer all the questions.        6×1=06 M 

16. List any two types of resources in event management. (CO1,BL1) 

17. What is staffing in event management? (CO2,BL1) 

18. Name one technology used in event management.( CO3,BL1) 

19. List any two revenue sources for an event.(CO4,BL1) 

20. Define virtual events.(CO5,BL1) 

21. Who are event volunteers?(CO5,BL1) 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (A) RAJAHMUNDRY 

(RE-ACCREDITED BY NAAC WITH ―A‖) 

(With effect from 2024-25 admitted Batch) 

I BBA H (EVENT MANAGEMENT) SEMETER - II 

EVENT HOSPITALITY AND SPONSORSHIP 

SYLLUBUS 

Hours: 04           Credits: 04 

 AIM: To equip individuals with skill to Plan, Manage, and Execute Events 

COURSE OUT COMES: 

CO1: To develop and understand the concept of event hospitality and sponsorship.  

CO2: To gain skill in managing Budget and financial management and logistics. 

CO3: To develop management skills in Accommodation. 

CO4: To evaluate sponsorship activation  

CO5: To develop skills about return on investment models. 

 

Unit 1: Introduction to Event Hospitality and Sponsorship. 

Definition-scope of event hospitality-types of hospitality-Definition - scope of sponsorship-Types of 

sponsorship  

Unit 2: Hospitality Operations and Logistics 

Event Planning and co-ordination for hospitality- event operations and logistics - supply chain management in 

hospitality events. 

Unit 3: Planning and Managing Hospitality at Events  

 On-site management -Hospitality planning - hospitality services- suite design and layout-catering and 

accommodation management -VIP and guest list management. 

Unit 4: Sponsorship Sales and Activation  

Identifying potential sponsors -sponsorship sales process-sponsorship activation (pre-event, post event. On site 

activation) developing sponsorship proposals - Techniques and contract basics. 

Unit 5: Sponsorship Strategies and Partnership  

Developing sponsorship objectives - strategies and proposals building and maintaining sponsorship 

partnership- sponsorship activation.- measurement of ROI. 

 

SUGGESTED BOOKS: 

1. "Event Management: For Tourism, Cultural, Business and Sporting Events" 

By Lynn Van Der Wagen & Brenda R. Carlos 

2. "The Event Manager's Bible: The Complete Guide to Planning and Organising a Voluntary or 

Public Event" 

 

ACTIVITIES: 1.Awareness to students how to show hospitality in the events 

                    2. Invited lectures on events (state/national/international) 

                    3. Attend events for observation 

                    4. To conduct small events on their own. 

                    5. Each student should frame 3 strategies for getting sponsorship. 

   

 

 



  Co-curricular activities: 

1. Event planning, budgeting, logistics 

 2. Marketing skills, public speaking. 
 3. Catering, 

 4. Organising college events 

 5.  Field trips to event industries 

 

  BLUE PRINT 

S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 1 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 2 1 2 

5 UNIT- V 1 1 2 

  

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – II 

EVENT HOSPITALITY AND SPONSORSHIP  

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Discuss the various types of hospitality and their relevance in event management. (CO1,BL2) 

OR 

2. Describe the scope and role of sponsorship in events. (CO1,BL2) 

3. Discuss the role of supply chain management in ensuring smooth hospitality operations.(CO2,BL2) 

OR 

4. Explain how supply chain management supports event hospitality. (CO2,BL2) 

5. Discuss in detail the process of planning and managing hospitality services during events.(CO3,BL2) 

OR 

6. Explain the elements of hospitality suite design and layout.(CO3,BL2) 

7. Examine the key elements of a successful sponsorship proposal with examples. (CO4,BL4) 

OR 

8. Describe the sponsorship sales process.(CO4,BL2)  

9. Evaluate the methods for building and maintaining successful sponsorship partnerships.(CO5,BL5) 

OR 

10. Describe the components of a successful sponsorship strategy.(CO5,BL3)  

 

Answer any THREE of the following.      3×3=09 M 

11. Explain the importance of hospitality in event management. (CO1,BL2) 

12. Explain the key elements of hospitality operations in events. (CO2,BL2) 

13. Explain the steps in hospitality planning for an event. (CO3,BL2) 

14. Explain the steps involved in identifying potential sponsors.(CO4,BL2) 

15. Explain the process of developing sponsorship objectives. (CO5,BL2) 

Answer all the questions.        6×1=06 M 

16. Define event hospitality. (CO1,BL1) 

17. What is event logistics? (CO2,BL1) 

18. Define on-site management.( CO3,BL1) 

19. Define sponsorship activation.(CO4,BL1) 

20. Define sponsorship activation.(CO4,BL1) 

21. What does ROI stand for?(CO5,BL1) 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-24 Admitted Batch) 

I BBA H (Event Management)– Semester – II 

                                                  Course Name: Computerized Accounting   

 Syllabus            

 Hours: 05         Credits: 04                                                        

               Course Outcomes: After completing the student will be able to 

CO1: Understand the meaning, objectives, functions, and importance of accounting, including 

accounting concepts and conventions. 

CO2: Students will be able to classify transactions into appropriate subsidiary books 

CO3: Students will be able to prepare and analyse basic financial statements 

CO4: Learn to create and manage companies in Tally ERP-9 

CO5: Understand and create accounting masters and vouchers in Tally ERP-9 

 

Unit I: Introduction to Accounting and Financial Statements Meaning, Objectives, Functions and 

Importance of Accounting – Accounting Concepts and Conventions – Users of Accounting 

Information. Accounting Cycle –Double Entry System- Journal, Ledger. 

Unit – II: Subsidiary Books 

Subsidiary Books – Definition - Types of Subsidiary Books – Cash Book, Three-column Cash Book – 

Petty cash Book and Trial Balance. (Problems). 

Unit III: Introduction to Financial Statements: Trading Account, Profit and Loss Account, and 

Balance Sheet.  

Unit-IV: Tally ERP-9-Company Creation-Tally Start-up Screen-Gateway of Tally- Create 

Company-Alter & Delete company-Backup and Restore- Security Features in Tally. 

Unit-V: Tally-Accounting Masters & Vouchers -Groups-Create Ledgers-Alter & Delete-Inventory 

Masters- Creating Stock Groups –Stock Items-Unit of Measurement-Alter &Delete. Tally-Voucher 

Entry-Vouchers Types -Vouchers Entry-Reports Generation. 

Reference books: 

1. Maheshwari, S.N. & Maheshwari, S.K. (2022). An Introduction to 

Accountancy. Vikas Publishing House.  

2. - "Tally ERP 9 for Beginners" by Firebrand Technologies 

3. - "Tally ERP 9: Accounting and Inventory Management" by K. K. Nadhani 

4. Tulsian, P.C. (2022). Financial Accounting for Managers. Pearson Education.  

 

 

 

 

 



CO-CURRICULAR ACTIVITIES: 

 

 Activity: Organize a guest lecture/seminar by a practicing Chartered Accountant on ―Importance of 

Accounting in Business Decision-Making.‖ 

 Activity: Conduct a quiz/MCQ competition on accounting concepts, conventions, and accounting 

cycle. 

 Activity: Workshop / hands-on practice where students prepare Cash Books and Trial Balance 

using given transactions. 

 Activity: Team activity – role play as ―business owners‖ and ―accountants‖ to record transactions in 

subsidiary books. 

 Activity: Case study analysis – students prepare Trading, P&L, and Balance Sheet from a 

company‘s trial balance. 

 Activity: Group presentation on the comparison of financial statements of two companies (using 

real annual reports). 

 Activity: Lab session on creating, altering, deleting, and securing companies in Tally ERP-9. 

 Activity: Organize an inter-class competition on ―Fastest Company Creation in Tally.‖ 

 Activity: Practical session on creating ledgers, stock items, and recording vouchers in Tally ERP-9. 

 Activity: Mini-project – Students prepare full accounting records of a sample business (sales, 

purchases, inventory, and reports) in Tally and present reports. 

 

BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 2 1 2 

2 UNIT-II 1 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 1 1 2 

5 UNIT- V 1 1 2 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management)– Semester – II 

Computerized Accounting   

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Explain the Concepts of accounting. (CO1,BL2) 

OR 

2. Write the journal entries in the following transactions. (CO1,BL6) 

2023 January    1 Purchased goods from Suresh Rs. 15,000 

    5 Sold goods to Hasini Rs. 30,000 

 10 Purchased Goods from Raju Rs. 5,500 

 11. Goods Returned to Suresh Rs. 1000 

 12. Sold goods to Raghu for cash Rs. 25,000 

 15. Sold goods to Govind Rs. 7,000 

  18 Purchased goods from Ravi Rs. 3,000 

  20 Goods Returned by Govind Rs. 1000 

 24 Purchased goods from Kiran Rs. 15,000 

30 Sold goods to Krishna Rs. 5,000 

 

3. Categorize the different types of  subsidiary books.(CO2,BL2) 

OR 

4. Prepare a three column cash book from the following particulars. (CO2,BL6) 

     2023 April,      1 Cash in hand     2,500 

       1 Cash at bank     10,000 

       2 Paid into bank      1,000 

      5 Bought furniture and issued Cheque  2,000 

       8 Purchased goods for cash        500 

     12 Received from Mahesh        980 

         Discount allowed             20 

    14 Cash sales      4,000 

    16 Paid to kiran by Cheque    1,450 

         Discount allowed by him         50  

    19 Paid into bank         400 

    23 Withdrew from bank for Private Expenses     600 

    28 Withdrew from bank for Office use   2,000 

30 Paid rent by Cheque       800 

 

5. Explain meaning and Components of Financial statements.(CO3,BL2) 

OR 

6. On 31
st
 March 2016, the following trail balance was extracted from the books of Mohanlal. Prepare 

Trading& Profit and Loss a/c and Balance Sheet. (CO3,BL6) 

 
Particulars Debit Rs. Particulars Credit Rs. 

Plant and Machinery 160000 Capital 100000 

Purchases 120000 Sales 352550 

Opening stock (1.4.2016) 60000 Returns 2000 

 

Discount 700 Discount 1600 

Bank Charges  150 Sundry Creditors 50000 

Sundry Debtors 90000   

Carriage Inwards 1500   

Carriage Outwards 2400   

Salaries 13600   

Manufacturing wages 20000   



Rent, rates & taxes 20000   

Advertisement 4000   

Cash in hand 1800   

Cash at bank 12000   

 506150  506150 

 

Adjustments: 

1. Write off Rs. 1500 as bad debts. 

2. Closing stock was valued at Rs. 30,000 

3. Provide provision for bad debts Rs. 1000 

4. Outstanding salaries Rs. 400 

5. Prepaid wages Rs. 500 

 

7. Explain the Gate way of Tally in Tally ERP 9. (CO4,B2) 

OR 

8. Write the steps to create a Company in tally ERP 9.(CO4,BL6)  

9. Explain multi ledger creation in tally ERP 9.(CO5,BL2) 

OR 

10. Explain the different types of vouchers in tally ERP 9.(CO5,BL2)  

Answer any THREE of the following.      3×3=09 M 

11. Discuss the Debit and Credit Rules. (CO1,BL3) 

12. Record the following transactions in the subsidiary books: (CO2,BL6) 

     2023 January    1 Purchased goods from Suresh Rs. 15,000 

    5 Sold goods to Hasini Rs. 30,000 

 10 Purchased Goods from Raju Rs. 5,500 

 11. Goods Returned to Suresh Rs. 1000 

 12. Sold goods to Raghu for cash Rs. 25,000 

 15. Sold goods to Govind Rs. 7,000 

  18 Purchased goods from Ravi Rs. 3,000 

  20 Goods Returned by Govind Rs. 1000 

 24 Purchased goods from Kiran Rs. 15,000 

                                     30 Sold goods to Krishna Rs. 5,000 

13. Explain the Profit and loss Account. (CO3,BL2) 

14. Present the Alter a Company.(CO4,BL2) 

15. Define a Ledger in Tally. (CO5,BL1) 

 

Answer all the questions.        6×1=06 M 

16. Define accounting. (CO1,BL1) 

17. State the Purchase book (CO2,BL1) 

18. Define Outstanding Expenses.( CO3,BL1) 

19. Define Company info.(CO4,BL1) 

20. List out the Vouchers in Tally ERP 9.(CO4,BL1) 

21. Discuss the Accounting cycle?(CO5,BL2) 

  

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade) \ 

(W.e.f. 2024-25 Admitted Batch) 

II BBA H (Event Management)– Semester – II 

Customer Relationship Management 

Syllabus           

 Hours: 04           Credits: 04                                                        

               Course Outcomes: After completing the student will be able to 

CO1: Understand the core concepts of CRM and its relevance to event management.  

CO2: Analyse customer behaviour and preferences using CRM data.  

CO3: Apply CRM tools for sales, marketing, and customer service in event planning.  

CO4: Develop and implement a CRM strategy for an event management company.  

CO5: Evaluate the effectiveness of CRM initiatives in improving event outcomes.  

Unit 1: Introduction to CRM: 

Definition: CRM, its components, and its importance in event management. CRM in Event 

Management: Explore how CRM systems can be used to manage event attendees, 

sponsors, and other stakeholders.  

Unit 2: CRM Processes and Customer Data Management: 

Understand the CRM cycle, including planning, execution, and evaluation of CRM 

strategies in event management. Collect, organize, and analyse customer data to understand 

preferences and behaviours. 

Unit 3: Customer Service and Support Sales force Automation: 

CRM tools and techniques for customer service - managing leads, sales processes, and 

customer interactions. Measuring CRM Effectiveness: Track and evaluate the success of 

CRM initiatives in event management 

Unit 4: CRM Strategy and Technology:  CRM Strategy development and 

Implementation for an event management company - CRM in the Tourism Sector: 

Specific application of CRM in the tourism industry, including event-related tourism- 

CRM software options and their features relevant to event management.  

Unit 5: Relationship Marketing and CRM in Practice: Relationship Marketing vs. 

Transactional Marketing - Building Brand Loyalty through Events - Emotional Engagement 

& Experiential CRM - Feedback Loops and Continuous Improvement. 

 

 

 

 



Activities: 

 Training of students by a related field expert. 

 Assignments including technical assignments like ERP – SAP CRM. 

 Seminars, Conferences, Discussions by inviting concerned institutions 

 Field Visit to nearby firms to study the CRM. 

 Invited lectures and presentations on related topics, each student has to visit at least 

one firm dealt with CRM and present a report. 

 Show how to integrate the internet customer self-service for B2B and B2C channels. 

 Show how to run CRM analytics through embedded competitors‘ analysis 

in opportunity management. 

 Quiz and Class seminars 

 Case studies 

 Group discussions 

 Debates 

Reference Books: 

1. CRM at the speed of light by Paul Greenberg, YMH 2nd edition. 

2. Customer Relationship Management by V Kumar, Werner J Reinartz, WILRY India edition. 

3. Customer Relationship Management by Kristin Anderson and Carol Kerr, TM. 

4. Customer Relationship Management: Concepts & Application ,Alok Kumar, Chabbi Sinha 

& Rakesh Kumar, Biztantra, Delhi, 2007 

BLUE PRINT 
S.No Unit Very Short Answers  

(1M) 

Short Answers 

(3M) 

Essay 

(7M)  

1 UNIT-I 1 1 2 

2 UNIT-II 1 1 2 

3 UNIT-III 1 1 2 

4 UNIT-IV 2 1 2 

5 UNIT- V 1 1 2 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

(W.e.f. 2024-25 Admitted Batch) 

II BBA H (Event Management) SEMESTER-II 

Customer Relationship Management 

Time: 2 ½ Hours         Max Marks: 50 

 

      SECTION – A                     (5×7=35 Marks) 
Answer any FIVE of the following.  

1. Define CRM and Explain the components of CRM.(BL2,CO1) 

OR 

2. Explain the importance of CRM. (BL2,CO1) 

3. Explain the CRM Cycle.(BL2,CO2) 

OR 

4. Discuss the CRM Strategies in Event Management. (BL2,CO2) 

5. Explain the CRM tools and Techniques of Customer service. (BL2,CO3) 

OR 

6. Explain the track evaluate the success of CRM initiatives in event management .(BL2,CO3) 

7. Explain the Application of CRM.(BL2,CO4) 

OR 

8. Explain the CRM strategy and Technology. (BL2,CO4) 

9. Compare between Relationships Marketing VS. Transactional Marketing (BL4,CO5) 

OR 

10. Explain the Building Brand loyalty through events. (BL2,CO5) 

 

Answer any FIVE of the following.   (5×3=15 M) 

  
11. CRM in Event Management (BL6,CO1) 

12. Construct CRM cycle  (BL6,CO2) 

13. Define CRM Tools (BL1,CO3) 

14. State the Customer Interaction (BL1,CO4) 

15. Define Transactional Marketing  (BL1,CO5) 

Answer all the questions.       6×1=06 M 

16. Define Event Attendees(BL1,CO1) 

17. Define Customer Data Management (BL1,CO2) 

18. List out the CRM tools (BL1,CO3) 

19. Define CRM software (BL1,CO4) 

20. Present the CRM in Tourism (BL1,CO5) 

21. Define Relationship Marketing (BL1,CO5) 
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Government College (A) Rajahmundry 

(Re-Accredited by NAAC-A 

II BBA H (EVENT MANAGEMENT) 

Event Safety and Risk Management-SEM-III 

Syllabus 

Hours: 04           Credits: 04 

Course outcomes for Event Safety and Risk Management 

CO1: T0 know legal and regulatory requirements to execute events. 

CO2: To evaluate and identify prioritising risks 

CO3: To equip the students with risk mitigation strategies to control   risks. 

CO4: TO gain the skill in implementing safety and monitoring events 

CO5: To develop knowledge about legal regulations 

 

 Unit 1: Introduction to Event Safety and Risk Management 

Definition and Importance of Event Safety - Ethical and legal obligations of event organizers - Overview of 

Event Risk Management - Key Stakeholders in Event Safety - Understanding the interconnectedness of safety, 

risk management, and overall event success 

Unit 2: Risk Assessment and Analysis 

Identifying Event Hazards- Evaluating and Prioritizing Risks - Specific Event Risk Categories-Crowd 

management and control - Security threats (Security threats, Fire hazards-Food safety and hygiene standards) - 

Behavioural risks-Staff and volunteer safety. 

Unit 3: Event Risk Mitigation and Control 

 Developing Risk Mitigation Strategies - Creating a Comprehensive Risk Management Plan - Contingency 

Planning and Emergency Response - Utilizing Emergency Operation Centres (EOCs) for centralized 

coordination - Establishing clear communication channels and protocols. 

Unit 4: Implementation and Monitoring 
 Training and Staffing for Safety - Developing and delivering effective safety training for event staff and 

volunteers - Event Site Management and Security - - Implementing security measures (access control, bag 

checks, surveillance) - Real-time Monitoring and Communication -Managing media relations and crisis 

communication during incidents 

.Unit 5: Post-Event Evaluation and Legal Aspects 

Post-Event Assessment and Reporting - Conducting incident reviews and debriefings. Legal and Regulatory 

Compliance -Understanding relevant health and safety regulations, licensing, and permits insurance coverage-

Integrating safety as a core value in event planning and execution- risk management strategies. 

 

Blue print   unit I     unit 2    unit 3    unit 4    unit 5 

Essay                        2           2            2            2            2 

Short                         1           1            1          1            1 

                                     Very shorts                      2 1 1    1      1 

Suggested Books: 

The Event Safety Guide: 

 A Guide to Health, Safety and Welfare at Live Entertainment Events in the United States by Event Safety 

Alliance: This book provides safety guidance for the live event industry in the US. It's written in clear 

language and covers topics like emergency planning, weather preparedness, and specific technical issues. 



● Event Risk Management & Safety by Peter E. Tarlow: This offers practical strategies for managing 

risk at events of all sizes, covering topics from crowd control to emergency services. 

● Risk Management for Meetings and Events by Julia Rutherford Silvers: A comprehensive and 

practical guide emphasizing identifying, assessing, and mitigating risks.  

 

   Activities:  1. Discussion safety 

                     2. Field visit to event organising industries. 

                     3. Group discussion on risk control 

                    4. Reporting on security measures 

                   5. Write a note on post event analysis of selected event, 

Co-curricular Activities 1. Consultation with any event organisers to know risks in events. 

                                         2.To collect the information about the safety measures  in events. 

                                        3. Know the strategies to follow in events. 

                                        4.To equip the knowledge to manage media. 

                                        5. To know how to evaluate post event analysis. 
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Government College (A) Rajahmundry 

(Re-Accredited by NAAC-A) 

II BBA H (EVENT MANAGEMNET) 

Event Safety and Risk Management-SEM-III 

Model question paper 

Time: 2 ½ hours       Max. Marks 50 

 SECTION A 

    Answer all questions                                                                                           5 x 7 = 35 

1. Write about Ethical and legal obligations of event  organisers (BT 6) 

     Or 

2. Explain the  Overview of Event Risk Management.(BT1) 

3. Define the steps involved in crowd management.(BT 1) 

         Or 

4. Analyse and explain some security threats in event safety (BT 4) 

5. Create a comprehensive risk management plan. (BT 6) 

     Or 

6. Define Utilizing Emergency Operation Centres for centralized coordination (BT 1) 

7. Analyse the process of Developing and delivering safety training for event staff and Volunteers. 

                                                                                                                                      (BT 4) 

  Or 

8. Design the plan of Managing media relations and crisis communication during Incidents (BT 6) 

9. Evaluate Post-Event Assessment and Reporting (BT 5) 

         Or 

10. Define risk management strategies. (BT 1) 

SECTION B 

Answer any Three of the following questions:      3 x 3= 09 M 

11. Importance of event safety (BT 1) 

12. Crowd management( BT 1) 

13. Behavioural risk (BT 2) 

14. Site management security (BT 1) 

15. Post event assessment (BT 3) 

SECTION C 

Answer all the questions.     6×1=06 M 

16. Event Safety (BL1) 

17. Event Hazards  

18. Event Risk Mitigation  

19. Real Time Monitoring 

20. Risk Management 

21. Key Stakeholders in Event Safety 

 

 

 

 

 

 

 

 

 



 
GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

(W.e.f. 2023-24 Admitted Batch) 

II BBA H (Event Management) SEMESTER-III 

COURSE TITLE: EVENT PRODUCTION PROCESS 

Course Outcomes: 

To impart knowledge and practical skills in planning, organizing, executing, and evaluating events. Emphasis 

is given to technical, creative, and managerial aspects of event production. 

CO1: Understand the scope, elements, and stakeholders of event production 

CO2: Develop event concepts, prepare budgets, plan logistics, and assess risks 

CO3: Execute event operations by managing stage design, technical setups, performers, and safety measures 

through effective coordination 

CO4: Evaluate event performance through feedback, ROI measurement, and documentation 

CO5: analyse and apply emerging technologies, sustainable practices, and industry trends 

UNIT 1: Introduction to Event Production 

Definition and Scope of Event Production, Types of Events: Corporate, Social, Cultural, Sports, Entertainment 

- Role of Event Producer  Elements of Event Production - Event Life Cycle: Pre-production, Production, Post-

production -  Key Stakeholders in Event Management 

UNIT 2: Pre-Production Planning 

Event Ideation and Concept Development, Budgeting and Financial Planning Venue Selection and Site 

Inspection- Event Timeline and Scheduling, Permissions- Licenses, and Legal Aspects -Team Formation and 

Vendor Management Risk Assessment and Contingency Planning. 

UNIT 3: Production and On-site Execution 

Stage Design and Layout Planning, Sound, Lighting, and Audio-Visual Setup - Event Flow Management and 

Cue Sheets-Artist and Guest Management Technical Rehearsals Safety-Security and Crowd Control 

Coordination with Vendors and Crews. 

UNIT 4: Post-Production and Evaluation 

Dismantling and Wrap-up Operations- Feedback Collection from Stakeholders- Performance Measurement 

and ROI- Report Writing and Documentation- Post-event Publicity and Media Coverage- Learning‘s and 

Future Recommendations. 

UNIT 5: Technology and Trends in Event Production 

 Use of Technology in Events (AR/VR, LED, Projection Mapping)- Event Management Software and Tools- 

Hybrid and Virtual Events- Sustainable Event Practices (Green Events) 

 Case Studies of Successful Events- Future Trends in Event Production. 

Suggested Activities: 

Organize a mock event - Prepare a production plan for a real or hypothetical event - Visit a live event setup - 

Work on a case study analysis 

Recommended Readings: 

 "Event Management & Planning" by Lynn Van Der Wagen 

 "The Event Marketing Handbook" by Allison Saget 

 Industry whitepapers and blogs (e.g., Eventbrite, Cvent) 

BLUE PRINT  

UNIT Name of the Topic 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1 M 

I Introduction to Event Production 2 1 1 

II Pre-Production Planning 2 1 1 

III Production and On-site Execution 2 1 1 

IV Post-Production and Evaluation 2 1 1 

V Technology and Trends in Event Production 2 1 2 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

II BBA H (Event Management) SEMESTER-III 

COURSE TITLE: EVENT PRODUCTION PLANNING 

MODEL PAPER 
Time: 2 ½ Hours         Max Marks: 50 

      SECTION – A                         (3×3=09 Marks) 

 
Answer any THREE of the following. 

 
1. What is the main difference between a corporate event and a cultural event? (BL1,CO1) 

2. What is "risk assessment"? (BL1,CO2) 

3. What does "AV" stand for in the context of event production? (BL1,CO3) 

4. Why is it important to collect feedback from stakeholders? (BL1,CO4) 

5. Define a "hybrid event."(BL1,CO5) 

SECTION-B 

Answer All the questions.       6×1=6 M 

6. What is "event ideation"? (BL1,CO2) 

7. What is the main purpose of a "cue sheet"? (BL1,CO3) 

8. List of Elements of Events (BL1,CO1) 

9. ROI (BL1,CO4) 

10. Virtual Events  (BL1,CO5) 

11. Hybrid Events  (BL1,CO5) 

       SECTION –B                            (5×7 = 35Marks) 

Answer ALL questions 

 
9. Definition of Event Production and discuss its scope and characteristics.(BL2,CO1) 

     Or 

10. Describe the three main stages of the event life cycle. (BL2,CO2) 

11. Discuss the critical components of the pre-production planning phase.(BL2,CO2)   

     Or 

12. Explain the importance of budgeting and describe the key steps in creating a budget. (BL2,CO2) 

13. Discuss the critical technical elements of on-site event execution. (BL2,CO3)   

       Or 

14. Discuss the comprehensive measures required for ensuring safety, security, and crowd control at a 

live event. (BL2,CO3) 

15. Describe the complete post-production and evaluation process for a major event. (BL2,CO4) 

     Or 

16.  Discuss the critical importance of performance measurement in event management. (BL2,CO4) 

17. Discuss the impact of emerging technologies like Augmented Reality (AR), Virtual  Reality (VR), 

and Projection Mapping on the event industry. (BL2,CO5) 

     Or 

18. Define "Sustainable Event Practices" (Green Events). Outline a comprehensive strategy for producing 

a green event. (BL2,CO5) 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+ ―Grade) 

(W.e.f. 2023-24 Admitted Batch) 

II BBA H (Event Management) SEMESTER-IV 

 DIGITAL MARKETING FOR EVENT MANAGEMENT  

Hours: 04      Credits: 04 

COURSE OUTCOMES:  

CO1: Identify target audiences and design a digital marketing strategy that aligns event brand positioning with 

the customer journey. 

CO2:  a platform-specific content and community plan that drives awareness, engagement and ticket 

conversion for an event. 

CO3: Design and justify a paid media plan and SEO approach that maximizes event visibility within a defined 

budget. 

CO4: Build an integrated email/CRM automation workflow that converts registrations and nurtures attendees 

pre- and post-event. 

CO5: Define KPIs, set up tracking, interpret results and recommend optimizations to improve event ROI and 

sponsor value.  

 

Unit I — Foundations of Digital Marketing for Events 

Role of digital marketing in event lifecycle (pre-event, during, post-event, Customer journey & event buyer 

personas, Branding, positioning and value proposition for events, Digital channels overview: websites, email, 

social media, search, display, affiliates, influencers. 

Unit II — Content, Social Media & Community Management 

Content strategy for events (content pillars, editorial calendar, UGC), Platform strategies: Facebook/Meta, 

Instagram, X (Twitter), LinkedIn, TikTok, YouTube, Community building, moderation, and live engagement 

(threads, live streams, stories) , Influencer & ambassador programs for events. 

Unit III — Paid Media, SEO & SEM for Events 

Fundamentals of paid advertising: objectives, bidding, creative, audience targeting, Search Engine Marketing 

(Google Ads): search, display, remarketing, Search Engine Optimization for event pages (on-page, technical, 

local SEO), Budget allocation across channels, ROAS and CPA concepts. 

Unit IV — Email, CRM, Automation & Ticketing Integrations 

Email marketing best practices for events (segmentation, flows, lifecycle emails), CRM use-cases: lead 

capture, nurture, VIP management, Marketing automation and workflows (reminders, upsell, and re-

engagement), Integrating ticketing platforms, registration funnels, and payment gateways with marketing 

stacks. 

Unit V — Analytics, Measurement, Monetization & Emerging Trends 

Metrics and KPIs for events (awareness, acquisition, conversion, retention, LTV), Web & social analytics 

(Google Analytics 4, platform insights), conversion tracking, UTM strategy  

 A/B testing and campaign optimization, Monetization strategies: sponsorship activation, affiliate sales, 

hybrid/hybrid monetization models, emerging trends: AR/VR for events, AI content generation, privacy & 

cookie less implications 

Reference Books: 

 Philip Kotler, Gary Armstrong — Marketing: An Introduction (useful for branding, positioning, buyer 

personas) — any recent edition. 

 Tuten, Tracey & Solomon, Michael R. — Social Media Marketing (textbook covering platforms and 

strategy). 

 Chad S. White — Email Marketing Rules (practical, tactical book for lifecycle/email best practices). 

 Avinash Kaushik — Web Analytics 2.0 (measurement frameworks and actionable analytics). 

 

CO-CURRICULAR ACTIVITIES: 

 Activities: Persona workshop, channel-mapping exercise  

 Activities: Create a 4-week editorial calendar + 3 sample posts per platform  

 Activities: Create sample ad creative, keyword list, and campaign budget split  

 Activities: Map a registration-to-attendance automation flow; write sample emails for each stage  

 Activities: Analytics dashboard mock-up, A/B test plan, sponsor reporting template  



 

 

BLUE PRINT  

S.No UNIT 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1 M 

1 UNIT  I 2 1 1 

2 UNIT  II 2 1 1 

3 UNIT  III 2 1 1 

4 UNIT  IV 2 1 2 

5 UNIT  V 2 1 1 
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(Re-Accredited by NAAC with ―A+‖ Grade)  

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – IV 

DIGITAL MARKETING FOR EVENT MANAGEMENT  

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Evaluate the effectiveness of various digital channels (websites, social media, email, influencers) for 

event promotion. (CO1,BL5) 

OR 

2. Explain the role of digital marketing in different stages of the event lifecycle – pre-event, during 

event, and post-event.(CO1,BL2) 

3. Explain the elements of a content strategy for event marketing.(CO2,BL2) 

OR 

4. Design a community engagement plan using live streams, stories, and UGC (User-Generated 

Content). (CO2,BL6) 

5. Explain the objectives and components of paid advertising for events.(CO3,BL2) 

OR 

6. Compare SEO and SEM strategies for improving an event website‘s visibility.(CO3,BL4) 

7. Explain the role of email marketing across the event lifecycle.(CO4,BL2) 

OR 

8. Explain the Payment Gateways with marketing stacks.(CO4,BL2)  

9. Discuss the process of A/B testing and its role in campaign optimization.(CO5,BL2) 

OR 

10. Explain the key metrics and KPIs used to evaluate digital event campaigns. (CO5,BL2)  

 

Answer any THREE of the following.      3×3=09 M 

11. Define digital marketing in the context of events. (CO1,BL1) 

12. Define content pillars in digital marketing.(CO2,BL1) 

13. Differentiate between search ads and display ads. (CO3,BL4) 

14. Give two examples of lifecycle emails used for events. (CO5,BL1) 

15. Define conversion tracking.(CO5,BL1) 

 

Answer any THREE of the following.      6×1=06 M 

 

16. Give two examples of digital channels used in event marketing. (CO1,BL1) 

17. Define ROAS and CPA. (CO2,BL1) 

18.  Define CRM. (CO4,BL1) 

19. Define Email (CO4,BL1) 

20. Define SEO (CO3,BL1) 

21. List out the tools for Google Analytics (CO5,BL1) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

II BBA H (Event Management) SEMESTER-III 

Business Communication Skills  

 Hours: 04           Credits: 04 

 Course Outcomes:  

 CO1: Students will be able to explain the significance and scope of communication 
 CO2: Students will be able to distinguish between verbal (oral and written) and nonverbal communication. 
 CO3: Students will be able to explain the importance of interpersonal communication 

 CO4: Students will be able to recognize and overcome technological and socio-psychological barriers to   

                           Communication. 

 CO5: Students will be able to write effective formal reports and business letters 

 

            UNIT-I 

Concept of Communication – Significance, Scope – Communication Process – Essentials of good 

communication – Channels of Communication – Formal, Informal Communication – Upward, 

Downward, Horizontal Communication 

UNIT-II  

Types of communication: Verbal – Oral Communication: Advantages and Limitations of Oral 

Communication, Written Communication – Characteristics, Advantages & Limitations Nonverbal 

Communication: Sign language –Body language –Kinesics –Proxemics –Time language and Hepatics: 

Touch language. 

UNIT-III  

Introduction to Interpersonal Communication – Models of Interpersonal Communication – Importance 

of Interpersonal Communication – Communication Styles. Listening – Meaning and Types.  

UNIT-IV 

Barriers of Communication: Types of barriers – Technological – Socio-Psychological barriers – 

Overcoming barriers. 

UNIT-V 

Report writing–Formal reports–Writing effective letters–Different types of business letters - Interview 

techniques – Communication etiquettes 

 

References: 

  Business Communication, Shalini Varma, Vikas.  

 Business Communication, Raymond V.Lesikar, Neeraja Pandit et al.,TMH  

 English for Business Communication, Dr.T.M Farhatulla, PrismbooksPvt. Ltd.  

 Business Communications, Hudson, Jaico Publications 

BLUE PRINT  

UNIT Name of the Topic 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1 M 

I UNIT-I 2 2 1 

II UNIT-II 2 2 1 

III UNIT-III 2 2 1 

IV UNIT-IV 2 1 1 

V UNIT-V 2 1 2 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

II BBA H (Event Management) SEMESTER-III 

Business Communication Skills  
Time: 2 ½ Hours         Max Marks: 50 

      SECTION – A                         (3×3=09 Marks) 
Answer any THREE of the following.  

1. Design the Communication Process (BL6,CO1) 

2. Define Written Communication (BL1,CO2) 

3. Write about the Formal Communication (BL6,CO3) 

4. Write about Interpersonal Communication (BL6,CO4) 

5. Define Technological Barriers (BL1,CO5) 

                                                                  SECTION – B                         (6×1=06 Marks) 
Answer any FIVE of the following.  

6. Define Communication (BL1,CO1) 

7. Define Listening (BL1,CO3) 

8. Define Formal Reports (BL1,CO5) 

9. Define Oral Communication (BL1,CO2) 

10. List out the barriers of Communication (BL1,CO4) 

11. Business Letters (BL1,CO5) 

      SECTION – C                      (5×7=35 Marks) 
Answer any FIVE of the following.  
 

12. Explain the Elements of Communication (BL2,CO1) 

OR 

13. Summarize the Essentials of Good Communication (BL2,CO1) 

14. Describe the Different types of Communication.(BL2,CO2) 

OR 

15. Discuss the Advantages and Limitations of Oral Communication. (BL2,CO2) 

16. Describe the Models of Interpersonal Communication. (BL2,CO3) 

OR 

17. Explain the Communication Styles.(BL2,CO3) 

18. Explain the barriers of Business Communication.(BL2,CO4) 

OR 

19. Explain the how to overcoming the barriers. (BL2,CO4) 

20. Explain the different types of Business Letters. (BL2,CO5) 

OR 

21. Design Report writing. (BL6,CO5) 
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GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

II BBA H (Event Management) SEMESTER-IV 

EVENT COST ACCOUNTING  

 Hours: 05        Credits: 04 

COURSE OUTCOMES 

CO1:  Understand the objectives, scope, and elements of event cost accounting 

CO2: Apply break-even point analysis and volume-profit analysis to event management 

CO3: Understand the concept of budgeting as a control system in event management. 

CO4: Learn to make and monitor a budget for an event 

CO5: Understand the various income categories and expenses associated with event management 

 

UNIT - I : Introduction to Event Cost Accounting, Objectives and scope of Event Cost Accounting, Event 

Cost centers and Cost units, Event Cost classification, Profit measurement, Decision making and control, 

Elements of Costing system, Cost Ascertainment, Material Cost, Employee Cost, Direct Expenses, Overheads, 

Making of a Cost Statement and Profit Calculations. 

 UNIT – II: Event Costing - Fixed Cost & Variable Cost, Volume Profit Analysis, Break Even Point, B.E.P. 

Analysis for Events, B.E.P. Analysis As Applied To Event Management And Tactical Decisions.  

UNIT-III: Concept of the budget as a control system and the use of responsibility accounting in Event 

Management. Essentials of Budgeting for Event Management, Types of Budgets in Event Management. 

Sponsorship and Budgeting of Events. 

UNIT – IV: Budget and Events - Introduction, Making the Budget, do‗s, don‗ts, Contingency, Monitoring 

The budget, Budget Review, Budget Control & Variance.  

UNIT –V: Income Categories for an Event, Expenses, Venue, Outdoor Venues, Indoor venues, Budget for 

Sets, Security, Sound & Lights, Generators, walkie talkie, Pyros, Advertising PR, Print, Hoardings, Buses, 

Public Relations, Performers, Use Of Cost Centers In Event Management, Event Management Fees, 

Percentage of the total event cost, flat fees, package price.  

Suggested Readings:  

 Advanced Accountancy - R.L.Gupta and Radhaswamy  

 Management Accounting - Brown and Howard  

 Management Accounting - Khan and Jain  

 Management Accounting - S.N.Maheswari. 

Co-Curricular Activity: 

 Prepare a cost statement for a hypothetical event, calculating material cost, employee cost, direct 

expenses, and overheads. 

 Conduct a break-even analysis for a real-world event, identifying fixed and variable costs, and 

calculating the break-even point. – 

 Prepare a comprehensive budget plan for a hypothetical event, including sponsorship and budgeting 

considerations. 

 Create a budget plan for a real-world event, identifying potential risks and developing strategies for 

budget control. 

 Prepare a detailed budget breakdown for a hypothetical event, calculating income and expenses, and 

determining event management fees. 

 



 

BLUE PRINT  

S.No UNIT 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1M 

1 UNIT  I 2 1 1 

2 UNIT  II 2 1 1 

3 UNIT  III 2 1 1 

4 UNIT  IV 2 1 1 

5 UNIT  V 2 1 2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade)  

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management)– Semester – IV 

Event Cost Accounting  

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Explain the objectives and scope of event cost accounting in modern event management. (CO1,BL2) 

OR 

2. An event manager wants to evaluate the cost performance of two product launches (Event A 

and Event B). 

Particulars Event A (₹) Event B (₹) 

Material 60,000 55,000 

Labour 40,000 42,000 

Overheads 25,000 20,000 

Revenue 1,50,000 1,30,000 

Calculate the profit for each event, compare results, and suggest which event was more 

cost-effective. (CO,BL4) 

3. Explain the difference between fixed cost and variable cost with event-based examples. (CO2,BL2) 

OR 

4. Calculate P/V Ratio,  

Break-Even Point (BEP),  

Margin of Safety. 

The below particulars are given:  

Fixed cost ₹1, 00,000;  

Variable cost per attendee ₹500;  

Selling price per attendee ₹1,000. (CO2, BL2) 

5. Define budget and explain its importance as a control system in events.(CO3,BL1&2) 

OR 

6. Prepare a simple event budget showing revenue and expenditure heads.(CO3,BL4) 

7. Explain the steps involved in making an event budget.(CO4,BL2) 

OR 

8. The following data relates to a music festival event organized by ABC Events: 

Particulars Budgeted (₹) Actual (₹) 

Venue & Setup 1,00,000 1,10,000 

Promotion 50,000 45,000 

Security 25,000 30,000 

Artists & Performers 80,000 90,000 

Miscellaneous 20,000 15,000 

Tasks: 
 Prepare a Budget Variance Statement. 

 Identify favorable (F) and unfavorable (U) variances. 

 Suggest two possible reasons for the unfavorable variances.(CO4,BL2)  



9. Explain the main income and expense categories in event budgeting.(CO5,BL2) 

OR 

10. Calculate Total Event Cost. (CO5,BL4) 

Venue ₹40,000;  

Security ₹10,000;  

Sound ₹15,000;  

Lights ₹12,000;  

Performers ₹20,000;  

Misc ₹3,000.  

Add 15% event management fee.  

 

Answer any THREE of the following.      3×3=09 M 

11. Compute total cost: Material ₹10,000; Labour ₹5,000; Overheads ₹2,000. (CO1,BL2) 

12. List two types of budgets used in event management. (CO2,BL1) 

13. Define is responsibility accounting. (CO3,BL1) 

14. Define budget control. (CO4,BL1) 

15. If budgeted profit = ₹50,000 and actual profit = ₹60,000, find the profit variance. (CO5,BL1) 

 

 Answer all the questions         6×1=6 M 

 

16. Define Event Cost Accounting. (CO1,BL1) 

17. Mention two income categories for an event. (CO5,BL1) 

18. Define Break-Even Point.(CO2,BL1) 

19. Budget Review (BL1,CO4) 

20. Sponsorships (BL1,CO3)  

21. Cost Centres (BL1,CO5) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+ ―Grade) 

II BBA H (Event Management) SEMESTER-IV 

PUBLIC RELATIONS 

Hours: 04      Credits: 04 

Course Outcomes:  

CO 1: The student will be able to develop and demonstrate strategic plans relating to Public Relations  

CO 2: Plan and execute ethically sound and socially responsible advertising strategies and public relations 

campaign  

CO 3: The student will learn the role of PR in various sectors, along with the ethical practices in the field.  

CO 4: The student will learn the difference between advertising and public relations. CO 5: The student will 

able to develop their skills of crisis management. It will also learn the role of electronic and social media. 

 

UNIT-I:  Public Relations-Meaning, Definition and Objectives. Importance and functions of Public Relations, 

Process of Public Relations, Principles of Public Relations. Relationship between Public Relations and 

Advertising. Difference between advertising and public relations.  

UNIT-II : Types of PR: Internal/externals, Publics of PR. Qualities and skills required for PR, 

Responsibilities of PR Professionals. Employing PR effectively to create goodwill and convey a positive 

brand image.  

UNIT-III: Role of Public Relations in Government, educational institutions, hospital, defense, corporate, 

political parties, etc.  

UNIT-IV : Role of PR in crisis management. Developing skills of handling situation in crisis Employ PR for 

event management. Writing Press release Media Relation as PR Function  

UNIT-IV: Essentials of Public Relations, organizing press conference, Press Tours, writing rejoinders, 

backgrounders, features. Ethical issues in PR: Apex bodies in PR. Role of electronic and social media in 

Public Relation. 

Reference Books:  

1. Jethwaney, Jaishri N. and Sarkar, Narendra Nath (2015). Public Relations, New Delhi: Sterling Publishers 

Private Limited.  

2. Butterworth, Jefkins Frank, Public Relation Techniques, Heinmann Ltd. 

 3. Heat Robert L, Handbook of Public Relations, Sage Publications,  

4. Kaul J. M. and Nova Prakash, Public Relation in India, Calcutta 

 

Co-Curricular Activities:  

 Conduct a mock PR campaign for a hypothetical company, identifying objectives, target audience, 

and key messages. 

 Develop a PR plan for a real-world organization, identifying internal and external publics and required 

PR skills. 

 Research and present case studies of successful PR campaigns in different sectors (government, 

education, healthcare, corporate, etc.). 

 Develop a crisis management plan for a hypothetical organization, including strategies for handling 

situations and communicating with stakeholders. 

 Write a press release and develop a media relations plan for a real-world event or organization. 

 

BLUE PRINT  

S.No UNIT 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1 M 

1 UNIT  I 2 1 1 

2 UNIT  II 2 1 1 

3 UNIT  III 2 1 1 

4 UNIT  IV 2 1 1 

5 UNIT  V 2 1 2 

 

 

 

 



 

GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade)  

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – IV 

Public Relations   

Model Paper  

Answer all the Questions.         5×7=35 M 

1. Discuss the importance and functions of Public Relations in modern organizations. (CO1,BL2) 

OR 

2. Describe the process of Public Relations with suitable examples.(CO1,BL2) 

3. Explain the different types of Public Relation.(CO2,BL2) 

OR 

4. Discuss the qualities and skills required for a successful PR professional. (CO2,BL2) 

5. Explain the role of PR in government organizations.(CO3,BL2) 

OR 

6. Discuss how PR functions in educational institutions and hospitals. (CO3,BL4) 

7. Analyse the steps in writing a press release and its importance in PR.(CO4,BL4) 

OR 

8. Discuss how media relations contribute to effective PR functioning.(CO4,BL2)  

9. Explain the essentials of public relations.(CO5,BL2) 

OR 

10. Discuss the steps involved in organizing a press conference. (CO5,BL2)  

 

Answer any THREE of the following.      3×3=09 M 

11. State any two objectives of PR. (CO1,BL1) 

12. Name two sectors where PR is essential. (CO2,BL1) 

13. Mention one function of PR in corporate companies. (CO3,BL4) 

14. Define media relations in PR. (CO4,BL1) 

15. Define rejoinder in PR.(CO5,BL1) 

 

 Answer any THREE of the following.      6×1=06 M 

 

16. Define Public Relations. (CO1,BL1) 

17. Define ―Publics‖ in PR.(CO2,BL1) 

18. What is a press release? (CO5,BL1) 

19. PR in Education institutions (CO4,BL1) 

20. Press Tours (BL1,CO5) 

21. Crisis Management (BL1,CO3) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

II BBA H (Event Management) SEMESTER-IV 

 HUMAN RESOURCE MANAGEMENT IN EVENTS 

 Hours: 04        Credits: 04 

COURSE OUTCOMES:  

CO1: To develop basic understanding of Human Resource Management concepts and principles  

CO2: To familiarize students to the unique application of HR principles in the context of a highly complex 

event environment  

CO3: To understand the processes of managing a sizable & varied workforce in various types of events  

CO4: To acquaint students with HRM in context of international environment and ethical issues in HRM 

 

Unit 1: Introduction to human resources management in events: Significance, process, Key HR issues in an 

event organization, Human resources planning in context of event, Event Project Planning, Contractor 

management, Job analysis in event operations, HRM in the context of both mega events and smaller scale 

events  

 

Unit II:  Source of recruitment and selection in events, skills testing and selection of people for specific event. 

Job crafting and Job sculpting. 

 

Unit-III: Preparing human resources for event: Introduction to event management team and company, 

Workforce Training and Development training – training needs identification, training methods, Career 

Management and Talent Management  

 

Unit IV: Workforce policies and procedures, Compensation Management Job Evaluation –Meaning , 

Significance and Methods of Evaluation, Appraising and Managing Performance -Meaning, importance and 

methods of Performance Appraisal  

 

Unit V: Employee Morale – Employee Motivation and retention, Employee stability and turnover issues, 

Stress Management and Quality of Work Life. International HRM, Ethical Issues in HRM. 

 

Reference Books:  

 Wagen, Lynn Van and White, lauren . Human Resource Management for Event Industry, Taylor and 

Francis 

 Aswathappa, K , Human Resource Management, Mc Graw Hill Education  

 Mamoria and Rao, Personnel Management (Text and Cases) Himalya Publications  

  Gary Dessler, "Human Resource Management", Seventh edition, Prentice-Hall of India P.Ltd., 

Pearson. 

 

CO-CURRICULAR ACTIVITIES: 

 Conduct a case study of HR planning for a mega event, identifying key HR issues and strategies for 

contractor management. 

 Develop a recruitment plan for a specific event, including skills testing and selection criteria. 

 Design a training program for event staff, identifying training needs and methods. 

 Conduct a job evaluation exercise for event staff, using different methods of evaluation. 

 

BLUE PRINT  

S.No UNIT 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1 M 

1 UNIT  I 2 1 1 

2 UNIT  II 2 1 1 

3 UNIT  III 2 1 1 

4 UNIT  IV 2 1 1 

5 UNIT  V 2 1 2 



 

GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade)  

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – IV 

HUMAN RESOURCE MANAGEMENT IN EVENTS  

Model Paper  

SECTION –A  

Answer all the Questions.         5×7=35 M 

1. Explain the significance of Human Resource Management in event organizations. (CO1,BL2) 

OR 

2. Explain the steps in Human Resource Planning for a large conference event.(CO1,BL2) 

3. Explain the sources of recruitment available for event organizations.(CO2,BL2) 

OR 

4. Describe the selection process for hiring event staff for a large festival. (CO2,BL2) 

5. Discuss the importance of training and development in event management.(CO3,BL2) 

OR 

6. Explain the steps involved in identifying training needs for event staff.(CO3,BL2) 

7. Compare the different performance appraisal methods used in event organizations.(CO4,BL) 

OR 

8. Explain the importance of workforce policies and procedures in event management.(CO4,BL2)  

9. Describe the methods of motivating and retaining employees in event organizations.(CO5,BL2) 

OR 

10. Explain the concept of employee morale and its influence on event success. (CO5,BL2)  

SECTION-B 

Answer any THREE of the following.      3×3=09 M 

11. State any two key HR issues faced during event management. (CO1,BL1) 

12. State any two training methods used in event management. (CO2,BL1) 

13. Differentiate between career management and talent management. (CO3,BL4) 

14. List any two methods of performance appraisal. (CO4,BL1) 

15. Mention any two key elements of compensation management. (CO5,BL1) 

 

SECTION-C 

      Answer all the questions.                                                                              6×1=06 M 

 

16. Define Human Resource Management. (CO1,BL1) 

 

17. Define recruitment.(CO2,BL1) 

 

18. Define employee morale.(CO5,BL1) 

 

19. Job Evaluation (BL1,CO4) 

 

20. Talent Management (BL1,CO3) 

 

21. Internal HRM (BL1,CO5) 

 

 

 

 

 

 

 

 

 

 

 



 

 

GOVERNMENT COLLEGE (AUTONOMOUS), RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with “A+” Grade) 

II BBA H (Event Management) SEMESTER-IV 

Legal Aspects of Event Management 

 Hours: 04        Credits: 04 

 

 

Course Objectives 

 To understand the legal framework applicable to event management. 

 To develop knowledge of contracts, licenses, and permissions essential for event operations. 

 To examine intellectual property rights and safety laws in event contexts. 

 To apply ethical and legal standards to event planning and execution. 

 To evaluate case studies related to legal disputes in events. 

Course Outcomes (COs) 

After completing this course, students will be able to: 

CO1: Identify key legal principles governing events. 

CO2: Interpret the implications of contracts and agreements. 

CO3: Apply licensing and permit procedures in practical event contexts. 

CO4: Analyse legal and ethical issues in event operations. 

CO5: Evaluate risk management and compliance strategies. 
UNIT I: Introduction to Legal Framework and Event Industry 

Meaning and importance of legal compliance in events, Overview of Indian legal system and business 

laws relevant to events, Regulatory bodies and government departments involved, Laws related to 

event venues, public gatherings, and entertainment, Ethical issues and professional conduct in event 

management. 

UNIT II: Contracts and Agreements in Event Management 

Nature and essentials of a valid contract, Types of contracts in event management: artist, venue, 

catering, sponsorship, vendor, Breach of contract and remedies, Memorandum of Understanding 

(MoU) and Indemnity agreements. 
UNIT III: Licenses, Permissions, and Insurance 
Types of licenses: Entertainment license, Liquor license, PPL, IPRS, etc., Permissions from local 

authorities, police, fire, and municipal bodies, Insurance in event management: public liability, 

property, cancellation, Environmental and noise regulations for events. 
UNIT IV: Intellectual Property Rights and Media Laws 
Copyright, Trademark, and Patent relevance in events, Protection of event themes, logos, and 

creative materials, Music, broadcasting, and digital content rights, Defamation, privacy, and media 

coverage issues. 
UNIT V: Health, Safety, and Risk Management Laws 
Occupational Safety and Health (OSH) regulations, Crowd control, fire safety, and emergency 

management, Labor laws and employee welfare during events, Disaster management and 

contingency planning, Legal implications of negligence and safety lapses 

REFERENCE BOOKS 

1. Avtar Singh. Introduction to Law of Contract and Specific Relief. Eastern Book Company. 

2. S. Chandrasekaran. Legal Aspects of Business. Vikas Publishing House. 

3. Allen, J. Event Planning Ethics and Etiquette. Wiley. 

 



Co-Curricular Activities: 

 
 Students analyze real-world legal disputes in event management (e.g., licensing or contract issues). 

 Draft sample event contracts, MoUs, and indemnity agreements. 

 Visit to an event venue or municipal department to understand permissions and safety audits. 

 Mock event licensing and compliance process involving students as stakeholders (organizer, police, 

sponsor, etc.). 

 

 

BLUE PRINT  

S.No UNIT 

Theory  

Essay 

7 M 

Short 

3 M 

V.S 

1 M 

1 UNIT  I 2 1 1 

2 UNIT  II 2 1 1 

3 UNIT  III 2 1 2 

4 UNIT  IV 2 1 1 

5 UNIT  V 2 1 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GOVERNMENT COLLEGE (AUTONOMOUS) RAJAMAHENDRAVARAM 

(Re-Accredited by NAAC with ―A+‖ Grade)  

(W.e.f. 2025-26 Admitted Batch) 

I BBA H (Event Management) – Semester – IV 

Legal Aspects of Event Management 

Model Paper  

Answer All questions                   6×1=6M 

1. Define ―Contract‖.(BL1,CO1) 

2. Define Safety Lapses?(BL1,CO5) 

3. Name any two types of event licenses.(BL1,CO3) 

4. What is copyright?(BL1,CO4) 

5. What is indemnity?(BL1,CO3) 

6. What is an MoU?(BL1,CO2) 
Answer any THREE of the following.      3×3=09 M 

7. Describe the Overview of Indian legal system 

8. Explain the Breach of contract and remedies 

9. Explain the Types of licenses 

10. Describe the Patent relevance in events 

11. Discuss the Disaster management 

      

 

Answer all the Questions.         5×7=35 M 

 

12. Explain the importance of legal compliance in event management.(BL2,CO1) 

OR 

13. Describe ethical responsibilities of an event manager.(BL2,CO1) 

14. What are the essentials of a valid event contract? (BL1,CO2) 

OR 

15. Discuss types of vendor agreements used in events.(BL2,CO2) 

 

16. Explain the process of obtaining event licenses.(BL2,CO3) 

OR 

17. What are the key features of event insurance policies? (BL2, CO3) 

18. Discuss the significance of intellectual property in events. (BL2, CO4) 

OR 

 

19. Explain the role of media laws in event promotion.(BL2,CO4) 

20. What are the legal requirements for ensuring crowd safety? (BL2, CO5) 

OR 

 

21.  Explain the importance of disaster management plans in events.(BL2, CO5) 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SEMESTER V&VI 

 

 

 

 

 

 
 



Apprenticeship in Event Management (AEDP) 
 

SEMESTER: V & VI SEMESTER  

Course Type: Practical / Field Component 

Credits: 22+22 

Duration: 12 Months (Full-time) 

Prerequisite: Completion of core event management courses (Event Planning, Marketing, Legal 

Aspects, Finance, etc.) 

Course Objectives 

1. To provide hands-on exposure to real-world event management practices. 

2. To bridge theoretical knowledge with industry application through professional 

apprenticeship. 

3. To help students understand event planning, execution, budgeting, marketing, and 

compliance. 

4. To develop organizational, communication, and problem-solving skills. 

5. To enhance employability and professional readiness in the event management industry. 

Learning Outcomes (COs) 
After successful completion of the apprenticeship, students will be able to: 

CO1: Apply theoretical concepts of event planning and coordination in practical settings. 

CO2: Demonstrate understanding of licensing, safety, and legal compliance procedures. 

CO3: Execute specific event tasks such as vendor coordination, logistics, and hospitality. 

CO4: Exhibit professional behaviour, teamwork, and ethical practices. 

CO5: Prepare and present a comprehensive apprenticeship report with analysis and reflection. 

Structure of Apprenticeship 
Duration: 

 12 Months (Full-time)  

Placement Areas: 
Students may undergo apprenticeship in: 

 Event Management Companies (corporate, weddings, concerts, exhibitions) 

 Advertising & Public Relations Agencies 

 Hotel and Convention Centers 

 Government Tourism & Cultural Departments 

 Media & Production Houses 

 Non-Profit Organizations (for community or public events) 

 Event Licensing / Legal Consultancy Firms 

 

 

 

 

 

 

 



 

Suggested Apprenticeship Activities 

During the apprenticeship, students are expected to: 

Functional Area Practical Exposure / Tasks 

Event Planning Assist in developing event concepts, schedules, and layouts. 

Marketing & Promotion Work on event promotion, ticketing, and branding activities. 

Vendor & Client 

Coordination 
Support negotiations, vendor management, and contract follow-up. 

Licensing & Permissions 
Observe procedures for obtaining legal clearances (e.g., PPL, municipal, 

fire). 

Budgeting & Logistics Participate in cost estimation, materials handling, and logistics planning. 

On-site Execution Support event setup, registration, hospitality, and crowd management. 

Post-event Evaluation Collect feedback, analyse event performance, and prepare reports. 

 

 Documentation & Reporting 
Each student must maintain: 

1. Daily Logbook / Diary – detailing daily tasks and learning outcomes. 

2. Supervisor Certificate – signed by the organization‘s mentor. 

3. Final Report – summarizing the organization profile, activities undertaken, key learning‘s, 

and reflection on skills gained. 

 

 


